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1.  Read these instructions.  

2.  Keep these instructions.

3.  Heed all warnings.

4.  Follow all instructions.

5.  Do not use this apparatus near water.

6.  Clean only with dry cloth.

7.  Do not block any ventilation openings. Install in accordance with the 
manufacturer’s instructions.

8.  Do not install near any heat sources such as radiators, heat registers, 
stoves, or other apparatus (including amplifi ers) that produce heat.

9.  Do not defeat the safety purpose of the polarized or grounding-type 
plug. A polarized plug has two blades with one wider than the other. 
A grounding-type plug has two blades and a third grounding prong. 
The wide blade or the third prong are provided for your safety. If the 
provided plug does not fi t into your outlet, consult an electrician for 
replacement of the obsolete outlet.

10. Protect the power cord from being walked on or pinched particularly at 
plugs, convenience receptacles, and the point where they exit from the 
apparatus.

11. Only use attachments/accessories specifi ed by the manufacturer.

12. Use only with a cart, stand, tripod, bracket, or table specifi ed by the 
manufacturer, or sold with the apparatus. When a cart is used, use 
caution when moving the cart/apparatus combination to avoid injury 
from tip-over.

13. Unplug this apparatus during lightning storms or when unused for long 
periods of time.

14. Refer all servicing to qualifi ed service personnel. Servicing is required 
when the apparatus has been damaged in any way, such as power-
supply cord or plug is damaged, liquid has been spilled or objects have 
fallen into the apparatus, the apparatus has been exposed to rain or 
moisture, does not operate normally, or has been dropped.

15. This apparatus shall not be exposed to dripping or splashing, and no ob-
ject fi lled with liquids, such as vases, shall be placed on the apparatus.

16. This apparatus has been designed with Class-I construction and must 
be connected to a mains socket outlet with a protective earthing con-
nection (the third grounding prong).

17. This apparatus has been equipped with an two-pole, rocker-style AC 
mains power switch. This switch is located on the rear panel and 
should remain readily accessible to the user.

18. This apparatus does not exceed the Class A/Class B (whichever is 
applicable) limits for radio noise emissions from digital apparatus as 
set out in the radio interference regulations of the Canadian Department 
of Com mu ni ca tions.

ATTENTION — Le présent appareil numérique n’émet pas de bruits 
radioélectriques dépassant las limites applicables aux appareils numériques de 
class A/de class B (selon le cas) prescrites dans le réglement sur le brouillage 
radioélectrique édicté par les ministere des com mu ni ca tions du Canada.

19. Exposure to extremely high noise levels may cause permanent hearing 
loss. Individuals vary considerably in susceptibility to noise-induced 
hearing loss, but nearly everyone will lose some hearing if exposed to 
suffi ciently intense noise for a period of time. The U.S. Government’s 
Occupational Safety and Health Administration (OSHA) has specifi ed 
the permissible noise level exposures shown in the following chart.

     According to OSHA, any exposure in excess of these permissible limits 
could result in some hearing loss. To ensure against potentially danger-
ous exposure to high sound pressure levels, it is recommended that all 
persons exposed to equipment capable of producing high sound pres-
sure levels use hearing protectors while the equipment is in operation. 
Ear plugs or protectors in the ear canals or over the ears must be worn 
when operating the equipment in order to prevent permanent hearing 
loss if exposure is in excess of the limits set forth here. 

Important Safety Instructions

WARNING — To reduce the risk of fi re or 
electric shock, do not expose this apparatus 

to rain or moisture.

Duration Per Day  Sound Level dBA, Typical
 In Hours Slow Response Example

 8 90 Duo in small club

 6 92  

 4 95 Subway Train

 3 97

 2 100 Very loud classical music

   1.5 102

 1 105 Tami screaming at Adrian about deadlines

 0.5  110

  0.25 or less 115 Loudest parts at a rock concert

PORTABLE CART WARNING

Carts and stands - The
Component should be used
only with a cart or stand
that is recommended by
the manufacturer.
A Component and cart
combination should be
moved with care.  Quick
stops, excessive force, and
uneven surfaces may cause
the Component and cart
combination to overturn.

CAUTION    AVIS
RISK OF ELECTRIC SHOCK 

DO NOT OPEN
RISQUE DE CHOC ELECTRIQUE

NE PAS OUVRIR

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK
DO NOT REMOVE COVER (OR BACK)

NO USER-SERVICEABLE PARTS INSIDE
REFER SERVICING TO QUALIFIED PERSONNEL

ATTENTION: POUR EVITER LES RISQUES DE CHOC
ELECTRIQUE, NE PAS ENLEVER LE COUVERCLE.  AUCUN

ENTRETIEN DE PIECES INTERIEURES PAR L’USAGER.  CONFIER
L’ENTRETIEN AU PERSONNEL QUALIFIE.

AVIS: POUR EVITER LES RISQUES D’INCENDIE OU
D’ELECTROCUTION, N’EXPOSEZ PAS CET ARTICLE 

A LA PLUIE OU A L’HUMIDITE

   The lightning flash with arrowhead symbol within an equilateral 
triangle is intended to alert the user to the presence of uninsulated
"dangerous voltage" within the product’s enclosure, that may be 
of sufficient magnitude to constitute a risk of electric shock to persons.

   Le symbole clair avec point de fl che  l’int rieur d’un triangle 
quilat ral est utilis  pour alerter l’utilisateur de la pr sence  
l’int rieur du coffret de "voltage dangereux" non isol  d’ampleur 
suffisante pour constituer un risque d’ l ctrocution.

   The exclamation point within an equilateral triangle is intended to 
alert the user of the presence of important operating and maintenance 
(servicing) instructions in the literature accompanying the appliance.

   Le point d’exclamation  l’int rieur d’un triangle quilat ral est 
employ  pour alerter les utilisateurs de la pr sence d’instructions 
importantes pour le fonctionnement et l’entretien (service) dans le 
livret d’instruction accompagnant l’appareil.
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Then, when you have time, read this owner's 
manual. It contains descriptions of every knob, 
button, and slider on the console, and all the menus 
and windows on the touchscreens.

Throughout this manual you’ll fi nd illustrations 
with each feature numbered. If you want to know 
more about a feature, simply locate it on the appro-
priate illustration, notice the number attached to it, 
and fi nd that number in the nearby paragraphs.

This icon marks information that 
is critically important or unique 
to the X.200. For your own good, 
read them and remember them. 
They will be on the fi nal test.

This icon leads you to in-depth 
explanations of features and prac-
tical tips. While not mandatory, 
they usually have some valuable 
nugget of information.

Note: If you are unfamiliar with using a digital 
mixing console, refer to "Operational Basics" in the 
X.200 Quick-Start Guide for information on fader 
banks, V-Pot controls, and using the touchscreen.

Please write your serial number here for future 
reference (i.e., insurance claims, tech support, 
return authorization, etc.)

Purchased at:

Date of purchase:

Thank you for choosing a Mackie Digital X Bus 
for your next-generation digital recording console. 
The Digital X Bus offers you the fl exibility to confi g-
ure it for virtually any recording application through 
its extended card cage and I/O routing options. 
And it was designed with the ability to upgrade as 
advancements are made in digital recording technol-
ogy. But with 32-bit fl oating point processing, you 
have more power than just about any other digital 
mixing console in its class.

If you have any experience using a digital mix-
ing console, like our D8B, you’ll fi nd that using the 
Digital X Bus is very similar and you’ll be mixing 
away in no time. If this is your fi rst experience with 
digital mixing, we’ll run you through some of the 
unique aspects of using a digital mixing console. 
You will fi nd that once you’ve learned these differ-
ences and the incredible fl exibility that digital mix-
ing has to offer, you will have a very short learning 
curve, and wonder how you have lived without the 
power of digital mixing for so long.

HOW TO USE THIS MANUAL
We know that many of you can’t wait to get your 

new Digital X Bus hooked up, and you’re probably 
not going to read the manual fi rst (sigh!). So refer 
to the Digital X Bus Quick-Start Guide to help you 
get the mixer set up fast so you can start using it 
right away. At the end of the Quick-Start Guide are 
some hook-up diagrams that show typical hookups 
for tracking, mixdown, and using the Digital X Bus 
with a DAW (Digital Audio Workstation).
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Getting Started
Each mic input provides an individual phantom 

switch (+48 VDC), and a digitally controlled input 
trim. All these controls are found in the I/O Confi gu-
ration window.

Each line input on the Mic/Line 4 card has a cor-
responding –10 dBv/+4 dBu jumper (J10-J13) on the 
card that determines the input level reference point. 
These jumpers come pre-installed from the factory 
at a +4 dBu input level. However, if you have unbal-
anced or low line-level sources, you may choose to 
remove these jumpers and set the input reference 
to –10 dBv to better use the headroom of the mixer. 
You can physically see these jumpers on the printed 
circuit board of the card itself, and they can be 
removed simply by pulling them off the card. 

2. MIC/LINE 8 CARD
The Mic/Line 8 card has two female DB25 con-

nectors, one for inputs and one for outputs. The 
input connector accepts eight balanced analog in-
puts that can be switched between mic- or line-level 
inputs. As with the Mic/Line 4 card, each mic input 
provides a phantom power switch and a digitally 
controlled input trim.

The output connector provides eight balanced line-
level outputs. These DB25 connectors use the TAS-
CAM standard pinout for analog signal connections 
(the same standard used on the analog cards for the 
Mackie D8B and Hard Disk Recorder). If you are 
connecting these to another device using the same 
DB25 standard, you can use a DB25-to-DB25 audio 
cable. Otherwise, you will need to use DB25 cables 
that breakout to XLR, 1/4" TRS, or TT connectors.

Once you’ve unpacked your new 
Digital X Bus, you’ll want to posi-
tion it where you can sit comfort-
ably and reach the touchscreens 
and controls, and have relatively 

easy access to the rear panel, in case you need to 
make any changes to the connections. Typically, 
once you’ve set it up and made the connections, you 
won’t have to make any changes unless you change 
your external equipment.

Connections
The Digital X Bus comes with a Mix Out card (con-

trol room card) and a Sync card already installed in 
the card cage in the rear panel. There are also con-
nections for a USB mouse/keyboard, footswitches, 
MIDI and other fun stuff. While not required to oper-
ate the Digital X Bus, the mouse and keyboard can 
be handy for quickly entering data or when clicking 
is easier than touching (the touchscreen).

Depending on your particular confi guration and re-
quirements, we have a variety of analog or digital I/O 
cards that you can install in the card cage to suit your 
application. Here’s a quick run-down of what we offer:

I/O Cards

1. MIC/LINE 4 CARD
This card has four female XLR balanced micro-

phone inputs, and four 1/4" TRS balanced/unbalanced 
line-level inputs, for a total of eight analog inputs. 
Note that this card does not provide any outputs. 

WORD
CLOCK

SYNC CARD

IN

OUT

IN

OUT

SMPTE

A

B

MIX OUT CARD

SPDIF

SPEAKERS

PHONES

MIX OUT

IN

OUT

IN

L R

1 2

L R

L R

OUT

AES/EBU

FIRE CARDDIGITAL CARD

OPTICAL

TDIF
I/O

IN A

IN B

OUT A

OUT B

MIC/LINE 4 CARD

5

7

6

8

1

2

3

4

MIC/LINE 4 CARD

5

7

6

8

1

2

3

4

MIC/LINE 8 CARD

IN

OUTI/O

AES CARD

OUT

IN

LINE CARD

OUT

LINE CARD

IN

SYNC C • SLOTSD • SLOT B • SLOTS A • SLOTS
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The Line card has two female DB25 connectors. 
One provides eight balanced line-level inputs, and 
the other provides eight balanced line-level outputs. 
They use the TASCAM standard pinout for analog 
signal connections (the same standard used on the 
analog cards for the Mackie D8B and Hard Disk 
Recorder). If you are connecting these to another 
device using the same DB25 standard, you can use 
a DB25-to-DB25 audio cable. Otherwise, you will 
need to use DB25 cables that breakout to XLR, 1/4" 
TRS, or TT connectors.

Refer to Appendix B for a wiring diagram of these 
connectors.

The Line card also has the –10 dBv/+4 dBu jump-
ers (described for the Mic/Line 4 card) that can be 
left in place (for +4 dBu operation) or removed (for 
–10 dBv operation).

Note: The Mic/Line 4 card, Mic/Line 8 card, and 
Line card all support analog-to-digital conversion at 
sampling rates up to 192 kHz and word lengths of 
either 16 or 24 bits.

4. DIGITAL CARD
This card provides up to eight channels of digital 

audio in two formats; TDIF-1 on a DB25 connector 
and ADAT optical on four TOSLINK connectors.

The input type is selected in software (either 
TDIF or ADAT). However, just because we can, we 
made both sets of outputs alsways active for you 
to use. This makes the Digital card a great format 
converter between TDIF-1 and ADAT optical digital 
devices.

At 44.1/48 kHz sample rates, each optical 
TOSLINK connector provides either eight inputs 
or eight outputs of digital audio. At 88.2/96 kHz 
sample rates, the S/MUX protocol is used to provide 
four channels of I/O on the “A” connectors, and four 
channels of I/O on the “B” connectors. At 176.4/192 
kHz sample rates, the S/MUX II protocol is used to 
provide two channels of I/O on the “A” connectors 
and two channels of I/O on the “B” connectors, for a 
total of four inputs and outputs.

Note: The TDIF connector does not operate above 
96 kHz.

5. AES/EBU CARD
The AES/EBU card has one DB25 connector, 

providing eight channels of digital I/O in the 
AES/EBU format. 

The original AES/EBU specifi cation (IEC958 Type 1) 
provides for carrying two channels of digital audio 
at resolutions up to 24-bit at 48 kHz. When higher 
sampling rates became possible, two methods were 
developed to transmit digital audio at the higher 
sample rates — double-fast and double-wide.

The double-fast method (also called single-wire) 
clocks the digital I/O port at twice the speed to get 
twice the information through, providing support for 
resolutions up to 24-bit at 96 kHz.

The double-wide method (also called dual-wire) 
transmits one channel of digital audio instead of two 
channels through a single digital I/O port, again pro-
viding support for resolutions up to 24-bit at 96 kHz.

The AES/EBU card currently uses the double-fast 
method, so eight channels of digital I/O are sup-
ported up to 192 kHz.

WORD
CLOCK

SYNC CARD

IN

OUT

IN

OUT

SMPTE

A

B

MIX OUT CARD

SPDIF

SPEAKERS

PHONES

MIX OUT

IN

OUT

IN

L R

1 2

L R

L R

OUT

AES/EBU

FIRE CARDDIGITAL CARD

OPTICAL

TDIF
I/O

IN A

IN B

OUT A

OUT B

MIC/LINE 4 CARD

5

7

6

8

1

2

3

4

MIC/LINE 4 CARD

5

7

6

8

1

2

3

4

MIC/LINE 8 CARD

IN

OUTI/O

AES CARD

OUT

IN

LINE CARD

OUT

LINE CARD

IN

SYNC C • SLOTSD • SLOT B • SLOTS A • SLOTS



11Owner's Manual

O
w

n
e

r's M
a
n

u
a
l

At sampling rates up to 48 kHz, two channels of 
digital audio are transmitted on a single wire (one 
3-pin XLR) at normal speed as specifi ed by the 
AES/EBU standard.

At sampling rates of 88.2/96 kHz, two channels of 
digital audio are transmitted on a single wire (one 
3-pin XLR) at twice the normal speed (2x).

At sampling rates of 176.4/192 kHz, two channels 
of digital audio are transmitted on a single wire (one 
3-pin XLR) at four times the normal speed (4x).

Note: Check the owner’s manual for the device you 
are connecting to the AES/EBU card, to fi nd out if 
it supports the double-fast (or single-wire) method.

The AES/EBU card is wired the same way as the 
Yamaha standard pinout for transmitting AES/EBU 
over a 25-pin cable. Be very careful about specifying 
these cables at a retailer or a cable manufacturer, as 
there are several varieties of 25-pin “D-Sub” cables 
and we want to be sure you get the correct ones! 
Make sure to specify, “25-pin, D-Sub AES/EBU digi-
tal cable wired in the Yamaha standard.”

6. FIREWIRE CARD
The FireWire card uses the IEEE-1394 protocol 

for connecting digital devices, and is compatible 
with standard Mac and PC FireWire connections. It 
currently provides 24 inputs and 24 outputs of digi-
tal audio at 48 kHz, and 8 inputs and 8 outputs at 
96 kHz (with room for expansion as driver technol-
ogy improves). 

It will appear as available patch points to any 
audio software application that supports one of the 
following formats:
 • ASIO 2.0 (Windows XP/2000)
 • WDM (Windows XP)
 • Core Audio (Mac OS X)

7. MIX OUT Card
This provides several outputs (with the addition 

of an AES/EBU and S/PDIF input), typically used 
for control room monitoring, headphones, and main 
outputs.

AES/EBU IN and OUT

These are XLR connectors that send and receive 
standard AES/EBU two-channel digital signals. The 
source for the AES/EBU OUT is selected in the Mix 
Out Card setup window (Window > I/O Confi gura-
tion > Touch the Mix Out Card). 

The default input numbers for the AES/EBU 
inputs are 65 and 66 in any of the Input Source As-
signment drop-down boxes. Even though the stereo 
AES/EBU input is intended for a digital two track 

return, you can assign them to feed channels, buses, 
the control room, or whatever you like.

S/PDIF IN and OUT

These are RCA-type connectors that send and 
receive standard S/PDIF two-channel digital sig-
nals. The S/PDIF OUT follows whatever is selected 
for the AES/EBU OUT in the Mix Out Card setup 
window. 

Touch the S/PDIF Input box in the Mix Out Card 
setup window to use the S/PDIF IN instead of the 
AES/EBU IN. 

The default input numbers for the S/PDIF inputs 
are 67 and 68 in any of the Input Source Assignment 
drop-down boxes. As with the AES/EBU inputs, you 
can route the S/PDIF inputs to feed channels, buses, 
the control room, or whatever you like.

SPEAKERS A and B

These are two sets of stereo monitoring outputs 
using 1/4" TRS jacks. They produce a line-level 
analog signal that you can connect to the inputs of 
the amplifi er powering your control room monitors 
(or the inputs to your active studio monitors).

The NEAR button in the CONTROL ROOM sec-
tion on the front of the console corresponds to the 
“SPEAKER A” outputs, and the MAIN button cor-
responds to the “SPEAKER B” outputs. 

The Control Room source is selected in the 
CONTROL ROOM section of the console (press the 
SETUP button in the CONTROL ROOM section for 
more setup options).

The Control Room Left and Right outputs are as-
signed to the SPEAKER A and B outputs by default. 
However, the source for the SPEAKER A and B 
outputs can be reassigned in the I/O Confi guration 
window (Windows > I/O Confi guration > Touch or 
Select the Mix Out Card).

PHONES 1 and 2

These are stereo 1/4" TRS jacks that provide a 
stereo output for headphones, or for connecting to a 
headphone distribution box. These are assigned to the 
Phones 1 and Phones 2 outputs by default, but can be 
reassigned to virtually any input or output source.

The Phones 1 and 2 sources are selected in the 
PHONES 1 or PHONES 2 section on the console 
(press the SETUP button in the PHONES section for 
more setup options).

MIX OUT

These are balanced 1/4" TRS jacks that provide a 
line-level analog signal. These are assigned to the 
left and right mix outputs by default, but can be reas-
signed to virtually any input or output source. Con-
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for mixdown, or to the inputs of a power amplifi er to 
drive a pair of speakers for the studio or whatever.

Note: Remember that the level for the Main L/R 
Mix Out is always controlled by the Master Fader 
on the console. The Control Room volume knob 
does not affect this level.

8. SYNC CARD
The Sync card provides word clock synchroni-

zation in and out of the console on a pair of BNC 
connectors, and SMPTE  time code (also called 
Longitudinal Time Code or LTC) in and out on a pair 
of 1/4" jacks.

The word clock input is the only means to slave 
the Digital X Bus sampling clock to an external 
clock reference device, such as a “house sync” box 
or a clock distribution system. The Digital X Bus 
can lock to a word clock source running between 
44.1 kHz to 192 kHz. The word clock input provides 
a 75 ohm termination, which prevents the clock 
signal from feeding back to the source and causing 
synchronization problems.

If you are slaving the Digital X Bus off an external 
word clock source, we do not recommend using the 
word clock output of the console to distribute that 
same clock signal to another digital device. There 
will be a certain amount of propogation delay from 
the input to the output, and this may cause a syn-
chronization problem between your Digital X Bus 
and other equipment. If you are using multiple digi-
tal devices in your studio, we recommend using a 
word clock distribution device that can send a word 
clock signal equally and evenly to all slave devices.

A note about clocking and sync:
The ADAT, AES/EBU, and SPDIF digital audio 
specifi cations include the presence of a “clock refer-
ence signal” through the same physical connection 
as the audio signals. This means that you can use 
the Digital X Bus as a master clock source, and 
lock several different digital devices to the digital 
audio outputs of the console. You need to refer to 
the external digital devices’ product documenta-
tion and/or manual(s) to learn how to lock external 
devices off the ADAT, SPDIF, or AES/EBU outputs 
of the Digital X Bus.

Remember that the Digital X Bus cannot slave to 
any external source unless it is locked via the word 
clock connection.

The SMPTE input can receive an LTC signal from 
24 through 30fps (frames per second) and includes 
support for “pull up” and “pull down” drop & non-
drop frames rates.

When using the Digital X Bus with a SMPTE 
input, we recommend locking the word clock of the 
Digital X Bus to the same source that is generat-
ing the SMPTE output. This will ensure that the 
console does not “drift” from your video or other 
playback source.

The SMPTE output simply mirrors the SMPTE 
input. Without a SMPTE input present, the SMPTE 
output will not be active. Even though the Clock 
Settings window has an “Internal” setting for the 
time code source selection, the Digital X Bus does 
not actually generate MTC or SMPTE signals at the 
corresponding outputs.

Time code is also provided through MIDI time 
code (MTC). SMPTE time code is more commonly 
used in motion picture and broadcast applications.
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115V 9V 9amp 6p 60Hz
230V 4.5V 4.5amp 5p 50Hz

11001100W MW Max

Other Connections

In addition to the cards in the card slots, there are 
more connections to be made on the rear panel.

9. FOOT SWITCH 1 and 2
These two 1/4" TS jacks are provided for foot-

switch control of various functions. These functions 
are assignable in the Windows > Setup window, and 
include Talkback, Play/Stop, Next Marker, Previous 
Marker, New Marker, and enabling/disabling the 
Fader Swap function.

10. SERIAL 9 PIN
This DB9 connector is an RS-422 port that sup-

ports the Sony® 9-Pin device protocol. It is con-
fi gured to operate as a controller, so it should be 
connected to a device (DEV) that is confi gured to 
be controlled by a controller (CONT). This is used 
primarily to transmit tape transport commands 
from the Digital X Bus to a Sony 9-Pin compatible 
recorder.

11. MIDI IN and OUT
These standard MIDI connectors (female 5-pin 

DIN) can be used to send or receive MIDI Time 
Code (MTC) and MIDI Machine Control (MMC) 
when connecting to equipment with transport con-
trols and a position display.

The MIDI connectors can also be used to control 
your DAW application when the MIDI fader bank is 
selected (up to eight channels).

You can turn MTC on and off in the Sync Card 
setup window (Windows > I/O Confi guration and 
touch the Sync card) by clicking the Generate MTC 
box. You can select MTC as the timecode source in 
the same setup window by clicking the TimeCode 
Source dropdown box and selecting MIDI (MTC).

The Digital X Bus has many different MIDI func-
tions — MMC, MTC, a MIDI Map, and the MIDI 
Control Surface. It is up to you to route the MIDI 
functions of the console to/from the physical MIDI 
port using the MIDI Patch Bay in the Setup window 
(Windows > Setup > MIDI).

If you need additional MIDI ports, you can at-
tach a third party USB MIDI interface to one of the 
USB ports on the rear of the console, load the third 
party drivers into the console, and use those ports 
for whatever MIDI transmissions you want to use. 
Please see “Connecting and Controlling a Digital 
Audio Workstation” for complete details on support-
ed USB MIDI Interfaces and how to confi gure them.

12. ETHERNET
This is a standard RJ45 telco connector. At the 

time of this printing, the Ethernet connector is dis-
abled. We reserve its use for future applications or 
feature enhancements to the Digital X Bus.

13. USB
The two USB ports on the Digital X Bus can be used 

to connect a USB equipped mouse, keyboard, or USB 
memory stick (USB fl ash memory). See “More Con-
nections” just ahead to see how to connect more USB 
devices, and a PS/2-style keyboard and mouse with a 
6-pin miniDIN connector.

14. IEC Power Receptacle
There are two power receptacles on the Digital X 

Bus, one to provide power to the Digital X Bus and the 
other to connect to another device and provide power 
to it. These are standard 3-prong IEC power connec-
tors. Connect the detachable linecord (included with 
your X.200) to the male power receptacle, and plug 
the other end of the linecord into an AC outlet with 
the correct voltage for your particular Digital X Bus.

To connect another device to the female IEC 
power receptacle, you need a power cord with a 
male IEC power connector on one end, and a female 
IEC power connector on the other end. These can be 
purchased at most electronic supply stores.

MIDI
IN

FOOT SWITCH
1                2

MIDI
OUTUSB ETHERNET SERIAL 9-PIN
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This one is self-explanatory. When the POWER 
switch is turned ON, power is supplied to the Digital 
X Bus and it boots up. When turning off the Digital 
X Bus, you should select SHUTDOWN from the File 
menu. At the end of the shutdown procedure, the 
Digital X Bus lets you know when it is okay to turn 
off the power switch.

Before turning on your Digital X Bus, please read 
the “Power-up Procedure” section on page 55 of this 
manual for complete step-by-step instructions.

MOUSE

KEYBOARD

VGA

DVI

USB PORTS

115V 9V 9amp 6p 60Hz
230V 4.5V 4.5amp 5p 50Hz

11001100W MW Max

16. Mouse
This 6-pin miniDIN connector is used to connect a 

PS/2 style mouse.

17. Keyboard
This 6-pin miniDIN connector is used to connect a 

PS/2 style keyboard.

18. USB
These are four additional USB ports for connect-

ing more USB devices to the Digital X Bus. If you 
are connecting a USB CD-ROM drive or a USB MIDI 
interface, use one of these ports rather than the 
USB ports on the rear panel (13).

19. Video Card
The video card has two connectors, one for each 

touchscreen. The upper connector is a VGA-type 
and connects to the left touchscreen, while the 
lower connector is a DVI-type and connects to the 
right touchscreen. You can use two video splitters to 
connect two external displays, if desired.

Note: The fi rst production run of X.200s requires 
that the external monitors be rotated 180º be-
cause the video signal is upside down. While 
testing the touchscreen displays, we determined 
that the clarity was better at the required viewing 
angle if the touchscreen displays were mounted 
upside down. If you are using external fl at-panel 
LCD or plasma displays, this is not a problem. 
However, conventional CRT-type displays gener-
ally will not work in this application.

Also note that the “touch” function does not work 
with an external display. This feature is built into the 
actual touchscreen displays on the Digital X Bus.

More Connections

There are even more connections available behind 
the removable panel on the back of the Digital X 
Bus. Use a small-headed Phillips screwdriver to re-
move the ten screws securing the panel to the chas-
sis to access these additional connections, which we 
call the Motherboard Access Area.



15Owner's Manual

O
w

n
e

r's M
a
n

u
a
l

Console Surface Controls
Touch the VU meter to open the DYNAMICS 

window. See "The Screens, The Windows Menu, 
Dynamics" for more info.

24. Equalizer
The small EQ window indicates whether the 

channel's equalizer is turned on (the EQ window 
lights up when the EQ is turned on). It also indi-
cates the EQ setting for the channel in a graphic 
display (amplitude vs. frequency).

Touch the EQ window to open the large EQUALIZ-
ER window. See "The Screens, The Windows Menu, 
Equalizer" for more info.

25. Surround
The small surround window indicates 

the surround panning for the channel, 
Left/Right and Front/Back. In stereo 
mode, it simply indicates the left/right 
panning of the channel. In surround 
mode, it indicates the surround pan 
position.

Touch the surround window to open 
the large SURROUND window. See "The 
Screens, The Windows Menu, Surround" 
for more info.

26. V-Pots
Just below the touchscreens are a row 

of rotary controls called V-Pots, which 
is short for virtual potentiometer. These 
correspond to the rotary control that ap-
pears at the bottom of the touchscreens.

Unlike an analog console where a 
rotary pot can control only one function, 
a digital console allows you to assign a 
V-Pot to many different functions.

Using the buttons to the right of the 
touchscreens, you can assign the V-Pots 
to control the following functions:

 PAN L/R (Left/Right)
 PAN F/B (Front/Back, 
     for surround sound)
 AUX 1-8 Send
 AUX 9/10 and 11/12 Send
 AUX 9/10 and 11/12 PAN
 Digital TRIM
 LEVEL TO TAPE

Channel Strip
The touchscreens are actually an extension of 

the channel strips, so we'll begin by describing the 
channel strip controls on the touchscreens.

20. Meters
The meters indicate the signal strength at a point 

in the signal path determined by the meters option 
setting (Options > Meters).

Touching the meter section toggles the display 
between a lower-resolution display of all the meters 
(Channels 1-72 + Aux 1-12 + Bus 1-8 + L/R mix), 
and a higher-resolution display of the meters for the 
selected fader bank.

Tip: An easy way to change fader banks is to 
toggle to all-meter display, then touch the section 
in the meter display corresponding to the fader 
bank you want to switch to. 

21. Assign
This section of the channel strip indicates the 

buses to which the channel is assigned, as well as 
the input source for the channel, the direct output 
assignment, and the pre- and post-insert assign-
ments.

Touch the assign section of the channel strip to 
open the ASSIGNS window. See "The Screens, The 
Windows Menu, Assigns" for more info.

22. Auxes
The Auxes section indicates the Aux Send level 

for Auxes 1-12 and the Aux Pan for Aux 9/10 (Cue 
1) and Aux 11/12 (Cue 2).

Touch the Auxes section of the channel strip to 
open the AUXES window. See "The Screens, The 
Windows Menu, Auxes" for more info.

23. Dynamics
The analog-style VU meter indicates whether the 

channel's compressor or gate are turned on (the 
meter lights up when the gate or compressor are 
turned on). When one of the dynamics processors 
are on, the meter indicates the input signal strength 
to the processors.
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24 V-Pots control that function for each of the 24 chan-
nels in the selected bank. 

In addition, windows that contain adjustable param-
eters, like the Dynamics and EQ windows, have their 
controls situated above the channel V-Pots, which 
temporarily become controls for the parameters in 
the window, overriding the V-Pot Assign selection. As 
soon as the window is closed, V-Pot control returns to 
whatever is selected in the V-Pot Assign section.

27. SELECT
•   Selects a channel for editing.

•   Double-pressing the SELECT button opens the 
Dynamics and EQ windows for that channel.

•   Pressing and holding the SELECT button opens 
the Channel Settings window (Channel > Chan-
nel Settings) for that channel.

•   Pressing and holding two SELECT buttons at 
the same time opens the LINK SETUP window 
for linking two channels.

28. ASSIGN
•   The function of the ASSIGN button is deter-

mined by what is selected in the ASSIGN BUT-
TON SETUP area.

•  When REC is selected, the AS-
SIGN buttons arm channels for 
recording via MMC (MIDI Machine 
Control). The ASSIGN button blinks 
to indicate REC READY status. 
When RECORD is activated in the 
Transport section, the ASSIGN but-
ton lights steadily to indicate the 
channel is recording.

•  When L-R is selected, the AS-
SIGN buttons indicate the channels 
that are assigned to the L-R mix 
bus. This lets you quickly assign and 

unassign channels from the L-R mix, and have 
an overall view of the assigned to the L-R mix 
for the selected bank.

• When READ is selected, the ASSIGN buttons 
determine which channels playback automation. 
If a channel has automation data associated 
with it and it is not Read-enabled, automation 
data will be ignored for that channel.

• When WRITE is selected, the ASSIGN buttons 
determine which channels can be written to au-
tomation. A channel must be Write-enabled (and 
the BYPASS button turned off in the AUTOMA-
TION MODES section) in order to write automa-
tion data for that channel.

29. SOLO
• Pressing SOLO lets you hear 

only the soloed channel in the 
Control Room output (or the Left 
and Right Mix if Mixdown solo 
is enabled).

• Select the solo mode in the 
SOLO section: PFL, AFL, and 
Mixdown (see the SOLO section 
description for more information 
on solo modes).

• The CLEAR button in the SOLO 
section blinks whenever any 
channel is soloed. Press the 
CLEAR button to turn off all 
SOLO buttons.

• Soloing multiple channels is 
accomplished by holding the 
SHIFT key (on the console or 
keyboard) while pressing the 
SOLO buttons on all desired 
channels. Also, selected Solo 
Latch in Windows > Setup > 
Mix Options allows you select 
multiple solos.

• Solo Isolate mode is accom-
plished by holding down the ALT 
key (on the console or keyboard) 
while pressing a channel’s SOLO 
button. A solo isolated chan-
nel is always active on the solo 
bus and therefore will not mute 
when other channels are soloed. 
The SOLO button blinks to indi-
cate Solo Isolate mode.

Note: The CLEAR button does not turn off Solo 
Isolated channels. You must hold down the ALT 
key while pressing the SOLO button to turn off a 
Solo Isolated channel.

30. MUTE
• Mutes the signal after the channel fader.

• Mute is prior to the L-R bus and Bus 1-8.

• Does not affect the Channel Out (Direct Out) or 
pre-fader Aux send. It does affect the post-fader 
Aux send.

31. Channel Fader
• Controls the signal level from the channel to the 

bus or buses it is assigned to (typically the L-R 
bus and the Bus 1-8 output).

• It does not affect the signal going to the Direct 
Out (Channel Out) or the pre-fader Aux send.
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Control Room Section
The Control Room section is where you defi ne the 

source for monitoring in your control room. Typi-
cally, you would use the Speaker 1 and Speaker 2 
outputs on the Mix Card for control room monitor-
ing, giving you the choice of near-fi eld and far-fi eld 
monitoring through the two stereo line-level speak-
er outputs. This is confi gured in the I/O Confi gura-
tion window (Windows > I/O Confi guration).

Press the SETUP button [32] in the Control Room 
section to open the Control Room Setup window.

• Select the output destination for the surround 
sound stems. When you are mixing in surround 
sound, you assign the eight bus outputs to the 
I/O cards in this window.

• Select the input source for control room moni-
toring. There are four buttons labeled 1, 2, 
Surround, and L-R. These correspond to the 
buttons on the console labeled 1, 2, SUR, and L-
R [33]. The Custom Input Assigns 1 and 2 drop-
down boxes are used to select virtually any 
input source for the left and right control room 
outputs. Select Surround to have your surround 
sound stems pass through the Control Room 
section. This allows you to have individual gain 
controls for each stem (at the bottom of the 
Control Room Setup window, using the console 
V-Pots), and activate the surround calibration, 
which sends pink noise to each surround output 
to verify that each speaker is set to the same 
relative volume.

•  Select Near 
(Speaker 1) or Main 
(Speaker 2) con-
trol room outputs 
[34/35].

•  Adjust the listen-
ing level of the Near 
or Main outputs with 
the knob [36] in the 
Control Room sec-
tion on the console, 
or the Near/Main 
control in the Con-
trol Room Setup win-
dow. The DIM button 
[37] allows you to 
temporarily duck the 
control room output 
by a preset amount, 
which you can set 
in the Control Room 
Setup window with a 
range of off (–∞) to 
0 dB.

Phones Section
The Phones section [38] allows you to select the 

input source for the headphone outputs (Phones 1 and 
2). Typically, you would select the C/R (Control Room) 
button for the headphone source, but you can have 
two custom sources confi gured in the Phones Setup 
window. Press the SETUP button in the Phones 1 or 
Phones 2 section to open the Phones Setup window.

• Click Copy Mix To Cue 1 or 2 to copy all the 
channel fader settings to Cue Mix 1 (Aux 9-10) 
or Cue Mix 2 (Aux 11-12). This is a quick way 
to copy the Master L-R mix, including effects, 
to the phones output.

• Click the Input Assign drop-down boxes to 
select two custom input sources for each head-
phone output.

• Adjust the headphone listening level with the 
knobs [39] in the Phones 1 and Phones 2 sections.

Talkback Section
The Talkback section allows you to communicate 

from the console to someone listening over the head-
phones. Press the SETUP button [40] in the Talk-
back section to open the TALKBACK SETUP window.

• Select the source for the talkback function by 
clicking the Source drop-down box. This can 
be either the built-in talkback mic in the Talk-
back section, or a microphone connected to an 
input card.

CONTROL ROOM

DIM SETUP

1 2

SUR

MONO

L - R

NEAR MAIN

PHONES 2PHONES 1

SOLOTALK BACK

TALK SETUP

1 2

SETUP C/R

1 2

SETUP C/R

AFL MIX
DOWN

PFL CLEAR
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channel is soloed. Press the CLEAR button to 
clear all soloed channels. This is particularly 
useful when working with solos across multiple 
fader banks.

• Adjust the solo signal level with the knob [46] 
in the Solo section.

Macros
The row of buttons just above the Transport 

section is called Macros [47]. It consists of eight 
buttons labeled 1-8 and a SHIFT button.

• The Macros buttons provide instant access 
to 16 frequently used windows or functions 
(Buttons 1-8 and SHIFT+ Buttons1-8).

• Defi ne the window or function executed by each 
button in the Macros Setup window (Windows > 
Setup > Macros).

Transport Section
This section provides control for external recorder 

transports, time display, snapshots, locates, and 
loops.

48. Number buttons 0-9

• Used to numerically enter Snapshot, Locate, 
and Loop points.

• When numeric buttons are used to enter data, 
you must press ENTER to complete the action.

49. ENTER button

• Initiates numeric changes that have been typed 
into the Recall Snapshot or Recall Locate win-
dows.

50. EDIT START

• Press this button to move the timeline cursor in 
the Mix Editor and the position display to the 
Edit In point.

51. END

• Press this button to move the timeline cursor in 
the Mix Editor and the position display to the 
Edit Out point.

• Click Talk to Phones 1 to send the talkback sig-
nal to the Phones 1 output, and Talk to Phones 
to send the talkback signal to the Phones 2 
output.

• Adjust the talkback signal level with the Level 
slider in the Talkback Setup window.

• Press the TALK button [41] in Talkback sec-
tion to activate the Talkback function and send 
the talkback signal to the selected headphone 
outputs.

Solo Section
The Solo Section lets you select the solo mode, 

clear all soloed channels, and adjust the solo level.

• Press MIXDOWN [42] to activate mixdown 
soloing. This interrupts the L-R mix output with 
the signal from the soloed channels.

• Use this mode whenever 
you want the soloed chan-
nels to be the complete 
mix—a rhythm section is a 
good example of this.

• Mixdown solo is post-DSP and post-fader.

• Press AFL [43] to monitor the post-fader signal 
in the Control Room output. This is a stereo bus 
(post-pan) so soloed channels are heard in their 
correct pan position.

• Press PFL [44] to monitor the pre-fader signal 
in the Control Room output. This is pre-pan as 
well, so the fader and Pan controls have no ef-
fect in PFL solo.

Note: If the channel fader is set low (less than 
unity gain), soloing the channel in PFL mode 
could result in a startling increase in volume. 
Be forewarned!

SOLOTALK BACK

TALK SETUP

AFL MIX
DOWN

PFL CLEAR

MACROS

SHIFT 1 2 3 4 5 6 7 8
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The Edit In and Edit Out points are used to copy, 
cut, and paste sections of automation data in the 
Mix Editor.

To set the Edit In and Edit Out points:

• Move the timeline cursor in the Mix Editor to 
the point where you want to start editing. Press 
STORE and then EDIT START.

• Move the timeline cursor in the Mix Editor to 
the point where you want to stop editing. Press 
STORE and then END.

• You can also click and drag the Edit In and Edit 
Out markers in the time bar in the Mix Editor 
screen, or click and drag across the screen to 
defi ne the start and stop points for an edit.

52. LOOP START

• Press this button to move the timeline cursor in 
the Mix Editor and the position display to the 
Loop In point.

53. STOP

• Press this button to move the timeline cursor in 
the Mix Editor and the position display to the 
Loop Out point.

54. ON

• Press this button to start loop playback from 
the points defi ned by the Loop In and Loop Out 
points in the Mix Editor.

To set the Loop Start and Stop points:

• Move the timeline cursor in the Mix Editor to 
the point where you want to start looping. Press 
STORE [55] and then LOOP START [52].

• Move the timeline cursor in the Mix Editor to 
the point where you want to stop looping. Press 
STORE [55] and then STOP [53].

• You can also click and drag the Loop In and 
Loop Out markers in the time bar in the Mix 
Editor screen.

56. SNAPSHOT

• To recall a snapshot, press SNAPSHOT, then 
enter a snapshot number using the number but-
tons, then press ENTER [49].

• To store a snapshot, with SNAPSHOT lit press 
STORE [55], then enter the snapshot number 
you want to use to store the console settings, 
then press ENTER [49].

• You can also open the Snapshot window (Win-
dows > Snapshots) to store and recall snapshots.

57. LOCATE

• To recall a locate point (moves the timeline cur-
sor to the locate point in the Mix Editor), press 
LOCATE, then enter the locate number using 
the number buttons, then press ENTER [49].

• To store a locate point, move the timeline cur-
sor in the Mix Editor to the position you want 
to put the locate point. With LOCATE lit, press 
STORE [55], then enter the locate number you 
want to use to mark the position, then press 
ENTER [49].

• To reset a locate point to a new location, move 
the timeline cursor in the Mix Editor to the new 
location. With LOCATE lit, press SET [58].

• You can also recall and store locate points in 
the Locator window (Windows > Locator).
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• To move the timeline cursor to a new position 
in the Mix Editor, with LOCATE [57] lit, press 
SET, then enter the time you want to move the 
cursor to using the number buttons, then press 
ENTER [49].

Transport Controls

These buttons control external devices that 
respond to MIDI Machine Control (MMC). MMC is 
transmitted from the MIDI OUT port on the rear pan-
el of the Digital X Bus to MMC-compatible devices.

Transport controls can be programmed to export 
specifi c MIDI messages other than standard MMC 
protocol. See MIDI Mapping for more details.

Note: MMC is not bidirectional. The Digital X 
Bus sends out MMC commands to your tape 
recorder(s), but if you arm tracks or operate trans-
port controls from the tape recorders, the activ-
ity is not transmitted back to the Digital X Bus 
via MMC. You can, however, press Play on your 
recorder and, as soon as time code is received, the 
Digital X Bus reverts to PLAY mode.

59. REWIND

• Engages external machine and the time code 
display to fast rewind.

60. FAST FWD

• Engages external machine and the time code 
display to fast forward.

61. STOP

• Stops external machines and the time code 
display at the current position.

62. PLAY

• Engages external machine and time code dis-
play to play at normal speed from the current 
location.

63. RECORD

• Engages Master record function on external 
machines.

• Must be pressed with PLAY to engage record 
mode unless One Button Record is active. One 
Button Record allows punching into record 
mode without hitting PLAY (see Windows > 
Setup > Mix Options).

64. SCRUB

• Engages the jog wheel to advance external ma-
chines forward or backward with single-frame 
accuracy when using MMC.
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The Screens

Accessing Windows

In addition, specifi c windows pertaining to a chan-
nel can be opened by simply touching that area in 
the channel strip.

Note: Touching an area on the touchscreen some-
times results in a different action than clicking 
the same area with the mouse.

For example:

• Touch the bus assign area just below the me-
ters on a channel strip to open the ASSIGNS 
window, which is also accessible by selecting 
Windows > Assigns.

 Click in the bus assign area to turn the individ-
ual bus assignments on and off, and to change 
input, insert, and direct output assignments.

• Touch the auxes section just below the channel 
number to open the AUXES window.

 Click in the auxes section to adjust the indi-
vidual aux send levels (and cue panning).

• Touch the VU meter to open the Dynamics win-
dow.

• Touch the EQ graphic display to open the Equal-
izer window.

 Click the EQ graphic display to turn the EQ on 
and off.

• Touch the Panning graphic display to open the 
Surround window.

 Click in the Panning graphic display to adjust 
the surround position.

The touchscreens provide an elegant user inter-
face for accessing and controlling the signals as 
they are routed through the Digital X Bus.

Overview
Before getting into the details of all the menu 

items and windows that are accessible on-screen, 
it’s worthwhile to mention at this point that a 
number of shortcuts are built into the touchscreen 
interface to quickly get to where you want to be.

Meters and Switching Banks

Touching the meters at the top of the screen 
toggles between a view of just the meters for the 
selected bank, or a total view of all 92 meters. The 
bank view provides a magnifi ed view with clipping 
indicators, while the total view allows you to see 
what is happening with all the channels, all at once.

Touching the meter for a specifi c channel or 
group of channels while in the total view causes 
the Digital X Bus to switch to the bank in which the 
channel or channels belong, while switching the 
meter view to the view for that bank. This allows 
you to quickly switch from one bank to another 
from the touchscreen.
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Contains:

 New Session (Ctrl+N)
 Open Session (Ctrl+O)
 Save Session (Ctrl+S)
 Save Session As… (Ctrl+Shift+S)
 Import D8B Session
 Save As Template…
 Open File Manager
 Launch Executable (.EXE)
 Install Packages…
 Shutdown (Ctrl+Q)

New Session (Ctrl+N)
• Press Ctrl+N on the keyboard, or touch File and 

then New Session.

• This opens a window that asks if you want to 
save changes to the current project fi rst. Select 
“Yes,” “No,” or “Cancel.”

• The Select Template window opens, which al-
lows you select a pre-saved template for your 
new project. Select a template if you wish and 
touch “OK,” or touch “Empty” to open the de-
fault new project template.

Open Session (Ctrl+O)
• Press Ctrl+O on the keyboard, or touch File and 

then Open Session.

Channel Layout Reconfi guration

The channel number provides access to a hidden 
menu that allows you to move channel strips around 
and to lock a channel strip so it is visible no matter 
what fader bank you have selected.

• Right-click on the channel number to open the 
channel assignment menu (or Alt+Touch the 
number).

• Select “Lock Channel” to lock the 
channel in place so it is visible 
with any fader bank selected. 
Select “Lock Channel” again to 
unlock it. (Alternatively, hold 
down the ALT button or ALT key 
and press a channel SELECT but-
ton to lock and unlock a channel.)

• Select “Reset All” to change all 
the channel strips back to their 
original confi guration (numerically sequential).

• Select “Reset Bank” to change all the chan-
nel strips in the currently selected fader bank 
back to their original confi guration (numerically 
sequential).

• Use the Channels, Masters, Groups, and MIDI 
submenus to reassign the channel strip position 
to a different channel.

• Select “Master Fader” to assign the Master 
Fader to the channel strip position.

Fader Swap

The Fader Swap button (located next to the time 
code display in the upper-right corner of the touch-
screen) causes the faders to take on the function 
of the V-Pots, allowing more precise control over 
a V-Pot setting. If it is a level function, fader-down 
is minimum and fader-up is maximum. If it is a 
pan function, the fader is centered when the pan is 
centered.

For example, a good use of the Fader Swap func-
tion is when you are doing a frequency sweep in the 
EQ. Using a channel fader to control this parameter 
gives you more physical space and throw with which 
to make your setting that much more accurate.

          

This chapter provides a quick (well, maybe not 
so quick, but certainly helpful) rundown of all the 
menus and screens accessible from the menu bar at 
the top of the touchscreen.
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Import D8B Session
• For Digital 8•Bus users, converts a D8B ses-

sion fi le to a Digital X Bus session.

Note: This feature imports channel fader, mute, 
and pan settings for channels 1-72, and the aux 
send levels/pans for auxes 1-12, along with the 
master aux sends ands buses 1-8 levels. Channel 
EQ, compressor, and gate settings are also im-
ported into the Digital X Bus session, but because 
the algorithms for the EQ and dynamics sections 
are different in the Digital X Bus, the sound will 
be somewhat different on the Digital X Bus than it 
was on the D8B.

Save As Template…
All new sessions are based on a template. A 

template is stored separately from sessions, but 
can be updated at any point with the current static 
mix levels, setup parameters, and channel settings 
of any given mix. Simply select Save As Template 
under the File menu.

• Allows you create a new template. For example, 
the default template sets all the faders down, so 
you can create a new template where the faders 
are all set to unity.

• Use this to open a pre-existing session fi le.

• As soon as the session is opened, the faders 
and all other parameters move to their proper 
settings for the current time code location.

Save Session (Ctrl+S)
• Press Ctrl+S on the keyboard, or touch File and 

then Save Session.

• Save the current session to its assigned loca-
tion on the hard drive.

• You can turn on the Digital X Bus Smart Save 
feature (Windows > Setup), which automati-
cally saves your session every XX minutes. If 
you have Smart Save turned off, be sure to save 
your session often to protect yourself from lost 
work—stuff happens.

Save Session As… (Ctrl+Shift+S)
• Press Ctrl+Shift+S on the keyboard, or touch 

File and then Save Session As…

• Opens the Save Session As window. Enter a 
new name for the session using the keyboard, 
or touch the Name box to open the on-screen 
keyboard.

• Touch Save to save the session to the default 
session folder, or you can navigate to another 
folder at the top of the Save Session As window.

• An extremely useful feature for saving varia-
tions of a session.

• Lets the current session be saved under a new 
name, leaving the original fi le untouched from 
that point on.

• Good for backing up session data under a new 
fi le name, or to an external USB Flash drive.
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• Gives you direct access to fi le management 
features such as copying or moving fi les and 
folders, deleting fi les, and creating new folders.

• Rename fi les.

• Allows you to copy and move fi les from the 
internal drive to an external drive for backup.

Note: The destination drive or folder must be 
opened and displaying its contents for proper 
placement to occur. You can't drag and drop fi les 
in the File Manager window. You must use the 
Move and Copy arrows.

Launch Executable (.EXE)

• Opens the Launch Installer window, which al-
lows you to browse to an executable fi le (.exe), 
a link to an executable (.lnk), or installer fi le on 
the hard drive.

• Used to install 3rd-party plug-ins, run third party 
authorizer applications, or MIDI interface drivers.

Install Packages…

• Opens the Package Installer window.

• Scans any attached USB peripheral for a 
Mackie-packaged installation fi le.

• Reports the status of all installers detected.

• Used for all Mackie-approved plug-in and soft-
ware installations.

Shutdown (Ctrl+Q)
• Press Ctrl+Q on the keyboard, or touch File and 

then Shutdown.

• The Digital X Bus asks you if you want to save 
the current session before shutting down. Select 
“Yes” to save the session, “No” to continue shut-
ting down without saving the session, or “Can-
cel” to continue working in the current session.

• In the Shutdown window, select “Shutdown” 
to close the Digital X Bus software, “Restart” 
to reboot the operating system, or “Cancel” to 
continue working in the current session.

• After shutting down, you will notice the mixer 
will turn off and the screens will shut off. Once 
that has happened, you need to turn off the 
power switch on the Digital X Bus. You must 
turn the switch to the off position before you 
can turn it back on to restart the console.
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Copy Filtered… (Ctrl+Shift+C)
• Opens the COPY FILTERED window. This al-

lows you to select the individual channel param-
eter data to copy to the clipboard.

These parameters include:
 Fader   Dynamics
 Mute   Buses
 Pan   Phase
 Auxes   Surround
 EQs   Assigns

• The selected channels parameter settings are 
not changed.

• The data on the clipboard can be pasted to an-
other channel. Only the selected parameters are 
pasted into the new channel. The unselected 
parameters are left intact.

• You can use the Undo command (Ctrl+Z) to 
undo a Copy Filtered command.

Paste (Ctrl+V)
• Replaces the parameters in a selected channel 

with the data in the clipboard.

• The data on the clipboard remains intact, so it 
can be pasted to multiple channels.

• You can use the Undo command (Ctrl+Z) to 
undo a Copy command.

Modify Levels…
• Opens the MODIFY LEVELS window. Use this 

control to modify individual parameters for the 
selected channel(s).

The Edit Menu
Contains:

 Undo (Ctrl+Z)
 Redo (Ctrl+Shift+Z)
 Cut (Ctrl+X)
 Copy (Ctrl+C)
 Copy Filtered… (Ctrl+Shift+C)
 Paste (Ctrl+V)
 Modify Levels…
 Insert Global Time…
 Delete Global Time…
 Clear Automation
 History List (Ctrl+H)
 Clear History
 Copy Mix To Bus

Undo (Ctrl+Z)
• Reverses an action. If you’ve made a bad 

automation pass, cut something you didn’t re-
ally want to cut, pasted somewhere you didn’t 
want to paste, etc., simply select Undo (or type 
Ctrl+Z on the keyboard) and the Digital X Bus 
reverts to its previous state.

• Selecting Undo multiple times steps back 
through the history list (list of actions taken), 
all the way back to the top level (starting 
point), if necessary. Open the History List 
(Ctrl+H) to check it out.

Redo (Ctrl+Shift+Z)
• Reverses an Undo. If you’ve undone an action, 

or set of actions, you might determine that your 
original guess was best, and want to return to 
actions you removed.

• Redo is a multilevel command, like Undo, so 
multiple redo commands retrace your steps 
through any undone actions in reverse order.

Cut (Ctrl+X)
• Copies all the selected channel’s parameter data 

to the clipboard and sets the channel’s param-
eters to their default settings.

• The data on the clipboard can be pasted to 
another channel.

• You can use the Undo command (Ctrl+Z) to 
undo a Cut command.

Copy (Ctrl+C)
• Copies all the selected channel’s parameter 

data to the clipboard and leaves all the selected 
channel’s parameters intact.

• The data on the clipboard can be pasted to 
another channel.

• You can use the Undo command (Ctrl+Z) to 
undo a Copy command.
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down box.

• Choose the action from Set, Trim, Min, and 
Max.

 Set moves the selected parameter setting to the 
specifi ed value for all selected channels.

 Trim adds or subtracts the specifi ed value from 
the selected parameter for all selected channels.

 Min limits the minimum value for the selected 
parameter, and applies it to all selected channels.

 Max limits the maximum value for the selected 
parameter, and applies it to all selected channels.

Insert Global Time…

• With the Mix Editor open, this feature globally 
inserts a region of no data change at the se-
lected start point (on all channels for all data).

• Selecting Insert Global Time in the Edit menu 
opens a window with settings for the insert 
start point and length of time inserted.

Delete Global Time…

• With the Mix Editor open, this feature globally 
deletes a region of data change at the selected 
start point (on all channels for all data).

• Selecting Delete Global Time in the Edit menu 
opens a window with settings for the deletion 
start point and length of time deleted.

Clear Automation
• Removes all automation data globally for the 

selected channels and the selected categories.

• The Mix Editor window must be closed to use 
the Clear Automation command.

• This action can be undone as long as it remains 
in the History List.

• Plug-in automation is cleared by removing the 
plug-in from the Effects Rack (Ctrl+8).

History List (Ctrl+H)
• The History List window lists actions taken in 

the Mix Editor. In addition, Automation Passes, 
Clear Automation, Delete Global Time, Insert 
Global Time, Delete Events, and Modify Levels 
commands are logged as single list items. Each 
of these actions is available for Undo, as long as 
they remain on the History List.
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• Using this list, it is possible to regress to any 
point in the mix. If at some point things went 
in the wrong direction, it is easy to go back to 
where the mix was on the right track.

• Highlight any item in the list to deactivate all 
forthcoming listed actions. When the mix is 
played, no actions listed below the selected 
event will occur.

• If an event is selected in the list and then a 
change is made in the Mix Editor, all events fol-
lowing the selection will be replaced by the new 
event.

• Use the Undo command from the Edit menu 
(Ctrl+Z) to regress through the History List 
steps one at a time.

• Use the Clear History command from the Edit 
menu to remove all events from the History 
List. This action cannot be undone.

Clear History
• Removes all items from the History window.

• This action cannot be undone.

Copy Mix To Bus

• Copies the current L/R mix to a pair of buses.

• Selections include Bus 1 and 2, Bus 3 and 4, 
Bus 5 and 6, or Bus 7 and 8.

• Check “Unassign from LR Mix” to remove the 
selected channels from the L/R Mix and copy to 
the selected bus pair.

The Channel Menu
The Channel menu contains:

 Channel Settings (Ctrl+B)
 Channel Presets
 Setup Groups (Ctrl+G)
 Un-Group
 Link Channels… (Ctrl+L)
 UnLink Channels (Ctrl+U)
 Faders to Unity (Ctrl+])
 Faders to Off (Ctrl+[)
 Adjust Channel Delay…
 Reset Channel Delay…
 Reset Selected Channels
 Select Fader Bank (Alt+A)
 Select All Faders (Alt+Shift+A)

Channel Settings (Ctrl+B)

• Allows for quick and easy setting of global 
channel parameters.

• Change the channel name.

• Easily set groups.

• Solo isolate channels.

• Quickly set channel links.

Channel Presets

• Allows you to save and open preset channel 
parameter settings.

• Click New to create a new channel preset. Enter 
the new name using the keyboard or on-screen 
keyboard.



28 X.200

D
ig

it
a
l 

X
 B

u
s • Channel linking allow you to control a pair of 

channels at the same time. All channel param-
eters can be linked, or just selected parameters. 
For instance, in many cases only the faders 
need to be linked; all other parameters should 
remain independent for the individual track.

• Any channel can be linked to any other channel.

• Linking allows a stereo channel to be input on 
two channels and controlled as a pair of con-
secutive faders.

• To link a pair of channels, select the left channel 
of an adjacent pair and choose Link Channels… 
from the Channel menu, or press Ctrl+L on the 
keyboard. The Link Setup window appears.

• To link a pair of non-adjacent channels, select 
the fi rst channel, then SHIFT+SELECT the 
second one, then select Link Channels from the 
Channel menu.

• Select the parameters that you want linked 
between the channels. All checked parameters 
are adjusted together for both linked channels.

• Select how you want the channels linked. In 
this case, we are linking channel 1 and 2.

 Check “Preserve Ch. 1’s values” to copy channel 
1’s parameters over to channel 2.

 Check “Preserve Ch. 2’s values” to copy channel 
2’s parameters over to channel 1.

• Click the Link button to link the channels you 
have selected, or click Cancel to cancel the link-
ing process.

• To link a pair of channels from the control sur-
face, press and hold the SELECT buttons of the 
two adjacent channels you wish to link. This 
opens the Link Setup window.

• Select Pan Inverse to have the pans linked 
inversely. This means that rotating the pan 
control on one channel causes the pan control 
on the linked channel to rotate in the opposite 
direction.

UnLink Channels (Ctrl+U)
• Removes a link between channels.

• Select a linked channel and then select Unlink 
Channels in the Channels menu.

Faders to Unity (Ctrl+])
• Sets the selected channel faders to unity.

• Affects faders only (including Master L/R faders). 
Does not affect any other channel parameters.

• Click Save to update the channel preset with 
the current selected channel’s settings. All the 
channel parameters (EQ, Dynamics, and DSP 
Insert patch points) are saved as well.

• Highlight the desired preset and click Load to 
copy the preset settings to the selected channel.

• Click the Preview box to observe the channel 
preset settings on the selected channel before 
clicking Load.

• Click Change Folder to organize channels into 
logical groups: band name, instrument type, 
singers, drums, guitars, etc.

Setup Groups (Ctrl+G)

• Provides a convenient way to group faders for 
control by a group master fader in the GROUPS 
fader bank.

• Simply select the group to which you want to as-
sign channels, and then select those channels on 
the console.

• This does not override any previous group set-
tings outside the selected channels; however, a 
channel can only be assigned to one group. The 
most current group selection does override a 
previous channel group assignment.

• This feature provides a way to add faders to an 
already existing group.

Un-Group
• Provides an easy way to remove channels from 

a previously established group.

• Select some or all of the grouped channels to re-
move the selected channel(s) from group status.

Link Channels… (Ctrl+L)
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Faders to Off (Ctrl+[)
• Sets the selected channel faders to off.

• Affects faders only (including Master L/R faders). 
Does not affect any other channel parameters.

Adjust Channel Delay…

• This features provides a means to shift chan-
nels in time, relative to each other.

• Select the channels that will remain at the 
original position; all unselected channels will 
be offset by the selected number of samples 
(±255).

• Use to compensate for phase and timing dis-
crepancies in a synchronization scenario or any 
multitrack playback/record device setup.

• For example, if you place a plug-in with 100 
samples of delay on a channel, the audio will be 
behind the rest of the channels by that amount. 
To compensate, you would select the channel, 
choose “Adjust Channel Delay” and enter a 
value of 100.

• The Channel Delay control appears in the As-
sign window for the selected channel.

Reset Channel Delay…

• This resets the delay to 0 ms on the selected 
channels.

• To reset all channels, Select All Faders 
(Alt+Shift+A), then select Reset Channel Delay.

Reset Selected Channels
• Resets the selected channels to their default 

settings (L/R assign, Level to Tape and Digital 
Trim to 0 dB, EQ on and fl at, Auxes off, Pan 
centered, Fader off, Gate and Compressor off 
and at default settings).

Select Fader Bank (Alt+A)
• Selects all 24 channels in the currently selected 

fader bank for clipboard, automation, and other 
operations pertaining to multiple channel modi-
fi cations.

Select All Faders (Alt+Shift+A)
• Selects all 118 channels in fi ve fader banks (not 

counting MIDI) for clipboard, automation, and 
other operations pertaining to multiple channel 
modifi cations.

The Options Menu
The Options menu contains:

 Solo Latch
 Automation
 Transport
 Meters
 DAW Emulation Mode
 Faders To Tape
 Route to Bank
 Bank to Outputs

Solo Latch
• When Solo Latch is selected (a checkmark ap-

pears next to Solo Latch in the Options menu), 
you can solo more than one channel at a time.

• When Solo Latch is off, only one channel may 
be soloed at a time.

• You can manually solo more than one channel 
when Solo Latch is off by pressing the Shift key 
while soloing multiple channels.

Automation Submenu
Bypass

• Selecting this option mirrors the BYPASS but-
ton on the console.

• When Bypass is selected, automation data is 
neither recorded nor played back.

• When Bypass is not selected, all write-selected 
parameter adjustments are written into automa-
tion data and referenced to time code.

Trim

• Selecting Trim mirrors the TRIM button on the 
console.

• Sets all faders to unity position (when “Trim 
From Unity” is selected in the Windows < Auto-
mation window) and assigns all parameter con-
trols (except mutes) to globally add or subtract 
from existing settings and recorded moves.
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plete set of automation moves. For example, if 
the vocal track is perfectly crafted and struc-
tured, yet the entire track needs to come up a 
couple of dB in the mix, fear not. Select Trim, 
start time code, enter WRITE mode and, with 
one move, increase the vocal track fader 2 dB 
throughout the duration of the pass.

Latch

• This determines the action of overwriting auto-
mation data during a pass.

• When Latch is selected (a checkmark appears 
next to Latch in the Automation submenu), au-
tomation data for the selected parameter begins 
to be overwritten as soon as the parameter’s 
control is adjusted and continues to be overwrit-
ten throughout a pass, even if the parameter’s 
control ceases to change.

• When Latch is off, automation data for the 
selected parameter begins to be overwritten as 
soon as the parameter’s control is adjusted, but 
as soon as the parameter’s control stops chang-
ing, the subsequent automation data is left 
intact.

Faders

• This readies the automation computer to record 
all fader movements for any write-enabled chan-
nel.

Mutes

• This readies the automation computer to record 
all mute activity for any write-enabled channel.

Pans

• This readies the automation computer to record 
all pan movements for any write-enabled chan-
nel.

• All surround pans are recorded as well as L/R 
positioning. However, surround output, depth of 
center, and LFE Level are not written with this 
selection (use Other/All to write automation for 
these parameters).

Other

• Sets the automation computer to record all pa-
rameter changes for the write-enabled channels, 
other than the individually selectable Faders, 
Mutes, and Pans.

Write Flyback

• This determines what happens to the parameter 
levels upon punch-out of automation record.

• When Write Flyback is selected (a checkmark 
appears next to Write Flyback in the Automa-
tion submenu), each parameter recorded into 
automation returns to its previously adjusted 
status at the end of a record pass. A track that 
was off for an entire arrangement snaps back to 
off, after the level is increased, when punched 
out of write-record.

• When Write Flyback is off, parameter adjust-
ments in automation remain at their last 
user-adjusted setting, even after the end of the 
automation pass.

Transport Submenu
Use Pre-Roll

• Sets the playback cursor a specifi ed amount 
ahead of the locate point.

• The amount of Pre-roll is set in the Windows > 
Setup > Mix Options window.

• Pre-roll is used to provide a set time period 
for all synchronized device transports to lock 
together.

• Ideally, Pre-roll is equal to the sync-lock time 
for the recording system’s transports so that 
synchronized playback is a reality by the time 
the devices roll past the locate position.

• Pre-roll is also useful when you are punching 
in a solo or voice overdub and want to give the 
talen some extra lead-in time to prepare record-
ing their part(s).

Record Safe

• When Record Safe is selected, the channel 
RECORD buttons will not engage. However, 
automation data can still be written.

One Button Record

• When this option selected, record mode is ac-
tivated by pressing the RECORD button in the 
control surface’s transport section.

• When One Button Record is not selected, the 
PLAY button must be held down while pressing 
the RECORD button to engage record mode.

• To punch out of record mode, simply press 
PLAY, STOP, REWIND, or FAST FWD.

• One Button Record only affects the punch-in 
procedure. The punch-out procedure is the same 
regardless of the status of One Button Record 
(hit any other transport button to punch out).
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AutoPlay

• When AutoPlay is selected, playback starts 
automatically when you jump to a locate point.

• This is handy when you are jumping from one 
locate point to another, listening for something 
in particular.

Meters Submenu
Show All Meters

• Select this option to display all 94 meters (in-
cluding the L/R mix).

• Touch the meter bridge in the display to toggle 
between showing the 24 meters in the currently 
selected bank and all meters.

Input

• The meters display the signal at the input, prior 
to any controls on the Digital X Bus.

Pre-Fader

• The meters display the signal just prior to the 
fader, post- Digital Trim, EQ, Compressor, Gate, 
and pre-fader insert.

Post-Fader

• The meters display the signal just after the 
fader.

VU Meters Submenu
• When VU Meters is selected, the meter bridge 

in the display changes to an analog VU-style 
meter.

• When VU Meters is off, the meter bridge 
changes to a vertical bar display.

Meter Reference Point

The next three options allow you to adjust resolu-
tion of the meter display. The higher the resolution, 
the more detail you can see in the signal as it ap-
proaches 0 dBFS.

–∞ to 0 dB

• The meters display the entire signal range from 
no signal to 0 dBFS.

–24 dB to 0 dB

• The meters display the signal from –24 dBFS to 
0 dBFS.

–12 dB to 0 dB

• The meters display the signal from –12 dBFS to 
0 dBFS.

Dynamics Submenu
These three options allow you to change what is 

being displayed in the VU meter in the dynamics 
section of the channel strip. These options have no 
effect on the meter bridge at the top of the screen.

In

• Displays the signal level at the input to the 
compressor.

Reduction

• Displays the amount of gain reduction being 
applied to the signal by the compressor. With 
no compression, the meter indicates fully right. 
As gain reduction is applied to the signal, the 
meter moves to the left to indicate the amount 
of gain reduction in real time.

Out

• Displays the signal level at the output of the 
compressor, after compression and makeup gain 
has been applied.

Peak Hold

• When Peak Hold is selected, a thin bar appears 
in the meter bridge display to indicate the level 
of recent transient peaks in the signal. The 
Peak Hold bar has a slower decay rate than the 
normal response of the signal meter.

• Peak Hold does not affect the meters when in 
VU mode.

Clear Overloads

• If the metered signal reaches 0 dBFS, the clip 
indicator at the top of the meter bridge blinks to 
indicate that digital clipping has occurred.

• The clip indicator continues to blink until you 
manually clear it, either by selecting Clear 
Overloads in the Options < Meters Submenu, 
or selecting Clear Overloads in the Windows < 
Setup < Mix Options window.

DAW Emulation Mode Submenu
Use the DAW Emulation Mode submenu to select 

a third-party DAW (Digital Audio Workstation) 
software for controlling with the MIDI bank of 
the Digital X Bus. Since the Digital X Bus has 24 
faders, when using the Mackie Control emulation 
mode, it works like a Mackie Control Universal with 
two eight-channel expanders.

One of the following DAW software applications 
can be selected in the DAW Emulation Mode drop-
down box in the MIDI bank (see next page):
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 Emagic Logic Audio
 DigiDesign Pro Tools HUI
 MOTU Digital Performer
 Steinberg Nuendo
 Steinberg Cubase SX/SL
 Cakewalk SONAR
 Adobe Audition/Cool Edit Pro
 RML Labs SAWStudio
 Sony Vegas
 Magix Samplitude/Sequoia
 Soundscape

Faders To Tape
• When Faders To Tape is selected, the Level To 

Tape V-Pot (Direct Out Level in the Assign win-
dow) from the selected channel’s output follows 
the channel’s fader position.

• For example, if channel 12 is assigned to direct 
out “AN Out 12,” adjusting channel 12’s fader 
directly affects the Level To Tape.

Route to Bank Submenu
This provides a shortcut to route 24 consecutive 

inputs to a selected bank.

Inputs 1-24

• Routes and assigns the hardware inputs 1-24 
(Cards 1-3) to the currently selected bank.

Inputs 25-48

• Routes and assigns the hardware inputs 25-48 
(Cards 4-6) to the currently selected bank.

Inputs 49-68

• Routes and assigns the hardware inputs 49-68 
(Cards 7-9) to the currently selected bank.

Bank to Outputs Submenu
This provides a shortcut to route the 24 outputs 

from the selected bank to 24 consecutive outputs.

Outputs 1-24

• Routes and assigns the outputs for the cur-
rently selected bank to hardware outputs 1-24 
(Cards 1-3).

Outputs 25-48

• Routes and assigns the outputs for the cur-
rently selected bank to hardware outputs 25-48 
(Cards 4-6).

Outputs 49-72

• Routes and assigns the outputs for the cur-
rently selected bank to hardware outputs 49-72 
(Cards 7-9).

The Windows Menu
The Windows menu contains:

 About
 Hot Keys
 Close All Windows
 Setup (Ctrl+1)
 Automation
 Snapshots (Ctrl+2)
 Locator (Ctrl+3)
 Equalizer (Ctrl+4)
 Dynamics (Ctrl+5)
 Surround (Ctrl+6)
 Auxes
 Assigns
 Mix Editor (Ctrl+7)
 Effects Rack (Ctrl+8)
 MIDI Map (Ctrl+9)
 DAW Bank
 I/O Confi guration (Ctrl+0)
 Tools Submenu

About
• This window displays the OS version, copyright 

information, and acknowledgements.

Hot Keys
• Displays a list of hot keys, or keyboard short-

cuts. The more of these key commands you 
learn, the faster and more effi cient you will be 
at recording. Some adjustments are necessary 
on the control surface or with the mouse or 
touchscreen, but many settings and windows 
can be changed or opened very quickly from 
the keyboard. Once you begin to incorporate 
these into your routine you’ll quickly realize the 
power and creative freedom they offer.
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Close All Windows
• This does just what it says, it closes all open 

windows in the display.

Setup (Ctrl+1)
The Setup window has four sub-windows: Gen-

eral, Macros, Mix Options, and MIDI, all selectable 
with the buttons at the top of the Setup window.

General

The General Setup window provides access to the 
following functions:

• Date and Time allows you to set the date and 
time for the Digital X Bus. This is important to 
keep your fi les in the correct chronological order.

• Touch Calibration initiates a routine to calibrate 
the touchscreens by having you touch a dot in 
the corners of both touchscreens. You may need 

to recalibrate the touchscreens from time to 
time, especially if it seems that the touchscreen 
isn’t responding as quickly as it should.

• Language selection is a drop-down box used to 
select your preferred language. English is the 
default setting.

• Smart Save is a function that automatically 
saves your sessions every fi ve minutes. Check 
the “Create New Files” box to save the session 
as a new session without overwriting the previ-
ously saved version. Check “Load Last Session 
at Power-up” to automatically open the last ses-
sion you were working on when you boot up the 
Digital X Bus, rather than the default Startup 
session.

Macros

The Macros window allows you to assign virtu-
ally any function to the Macro buttons in the Screen 
Sets section located above the Transport section on 
the control surface. This gives you quick and easy 
access to windows and frequently repeated actions.

Mix Options

Surround Mode

• This pull-down list provides access to the vari-
ous surround sound modes available on the 
Digital X Bus.
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able, including Stereo (no surround), Quad, 
LCRS, 5.1, 7.1 (SDDS), and 7.1 (TP).

Mixing Options

Several of the Mixing 
Options are also available 
under the Options menu.

One Button Record

• When this option is 
selected, record mode 
is activated by press-
ing the RECORD 
button in the control 
surface’s transport 
section.

• When One Button Record is not selected, the 
PLAY button must be held down while pressing 
the RECORD button to engage record mode.

• To punch out of record mode, simply press 
PLAY, STOP, REWIND, or FAST FWD.

• One Button Record only affects the punch-in 
procedure. The punch-out procedure is the same 
regardless of the status of One Button Record 
(hit any other transport button to punch out, 
usually STOP).

Solo Latch

• When Solo Latch is selected, you can solo more 
than one channel at a time.

• When Solo Latch is off, only one channel may 
be soloed at a time.

• You can manually solo more than one channel 
when Solo Latch is off by pressing the Shift key 
while soloing multiple channels.

Record Safe

• When Record Safe is selected, the channel 
RECORD buttons will not engage. However, 
automation data can still be written.

Use Pre-Roll

• Sets the playback cursor a specifi ed amount 
ahead of the locate point.

• The amount of Pre-roll is set in the Windows > 
Setup > Mix Options window.

• Pre-roll is used to provide a set time period for all 
synchronized device transports to lock together.

• Ideally, Pre-roll is equal to the sync-lock time 
for the recording system’s transports so that 
synchronized playback is a reality by the time 
the devices roll past the locate position.

Song Offset

• Sets the consistent time difference between the 
record device time code and the Digital X Bus 
reference time code.

•  Generally used to 
“zero reference” a song’s 
starting point in BBT. It’s 
easier to jump to measure 
1 than 2:01:23 (usually).

•  Offset can be as little 
as one frame or as much 
as 23 hours, 59 min-
utes, 59 seconds, and 29 
frames.

Pre-Roll

• Sets the time difference between a Locate point 
and the actual start point.

• Since many record devices require a few sec-
onds to synchronize, the Pre-Roll time allows a 
brief time period in advance of the locate point 
to ensure transport sync and accuracy.

Meters

These meter options are also available under the 
Options > Meters submenu.

The Meters drop-down box allows you to select 
the point in the signal fl ow where the meters are 
indicating.

Input

• The meters display the signal at the input, prior 
to any controls on the Digital X Bus.

Pre-Fader

• The meters display the signal just prior to the 
fader, post- Digital Trim, EQ, Compressor, Gate, 
and pre-fader insert.

Post-Fader

• The meters display the signal just after the fader.

Clear Overloads

• If the metered signal reaches 0 dBFS, the clip 
indicator at the top of the meter bridge blinks to 
indicate that digital clipping has occurred.

• The clip indicator continues to blink until you 
manually clear it, either by selecting Clear 
Overloads in the Options > Meters Submenu, 
or selecting Clear Overloads in the Windows > 
Setup > Mix Options window.
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Show All Meters

• Select this option to display all 94 meters (in-
cluding the L/R mix).

• Touch the meter bridge in the display to toggle 
between showing the 24 meters in the currently 
selected bank and all meters.

Peak Hold

• When Peak Hold is selected, a thin bar appears 
in the meter bridge display to indicate the level 
of recent transient peaks in the signal. The 
Peak Hold bar has a slower decay rate than the 
normal response of the signal meter.

• Peak Hold does not affect the meters when in 
VU mode.

Footswitches

These drop-down boxes allow you to select the 
function assigned to each of the two footswitch 
jacks available on the rear panel. The functions 
available include:

 • Talkback
 • Play/Stop
 • Next Marker
 • Previous Marker
 • New Marker
 • Fader Swap

MIDI

MIDI File Tempo Map

• Import a MIDI Tempo Map from a standard 
MIDI fi le to synchronize the Digital X Bus Bars/
Beats/Ticks display with your MIDI sequencer 
MTC reference.

Default Tempo

• Sets the MIDI tempo reference for position 
alignments during an automation pass or loca-
tor activities.

Active Tempo

• Displays the actual tempo currently in use.

MIDI Device ID’s

• Sets the Device ID reference for connected 
record devices such as the HDR24/96, ADATs, 
DA Series, or other multitrack recorders.

• A unique ID is required for using MMC (MIDI 
Machine Control) with multiple recording devices.

The following boxes select the MIDI port(s) used 
to send and receive MTC, MMC, and MIDI commands 
between the Digital X Bus and external multitrack 
recorders and DAW applications. The MIDI port(s) 
must be connected to the Digital X Bus in order to be 
detected and appear in the lists. MPU-401 is the built-
in MIDI IN and OUT connectors on the rear panel.

MTC In Port

• Selects the MIDI interface used to receive MIDI 
Time Code in the Digital X Bus.

MMC Out Port

• Selects the MIDI interface used to transmit 
MIDI Machine Control from the Digital X Bus.

MIDI Map In

• Selects the MIDI interface used to receive MIDI 
commands as defi ned in the MIDI Map.

MIDI Map Out

• Selects the MIDI interface used to send MIDI 
commands as defi ned in the MIDI Map.

DAW Main In

• Selects the MIDI interface used to receive MIDI 
commands for the fi rst eight channels when the 
MIDI fader bank is selected

DAW Main Out

• Selects the MIDI interface used to send MIDI 
commands for the fi rst eight channels when the 
MIDI fader bank is selected.

DAW Ext 1 In

• Selects the MIDI interface used to receive MIDI 
commands for the second eight channels (9-16) 
when the MIDI fader bank is selected

DAW Ext 1 Out

• Selects the MIDI interface used to send MIDI 
commands for the second eight channels (9-16) 
when the MIDI fader bank is selected.
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• Selects the MIDI interface used to receive MIDI 
commands for the last eight channels (17-24) 
when the MIDI fader bank is selected

DAW Ext 2 Out

• Selects the MIDI interface used to send MIDI 
commands for the last eight channels (17-24) 
when the MIDI fader bank is selected.

Automation
The Automation window provides access to some 

of the functions available under the Options < Auto-
mation submenu and the control surface, as well as 
some additional functions.

Bypass

• When Bypass is selected, automation data is 
neither recorded nor played back.

• When Bypass is not selected, all write-selected 
parameter adjustments are written into automa-
tion data and referenced to time code.

Trim

• Selecting Trim mirrors the TRIM button on the 
console.

• Sets all faders to unity position (when “Trim 
From Unity” is selected) and assigns all param-
eter controls (except mutes) to globally add or 
subtract from existing settings and recorded 
moves.

• This is perfect for raising or lowering a com-
plete set of automation moves. For example, if 
the vocal track is perfectly crafted and struc-
tured, yet the entire track needs to come up a 
couple of dB in the mix, fear not. Select Trim, 
start time code, enter WRITE mode and, with 
one move, increase the vocal track fader 2 dB 
throughout the duration of the pass.

Trim From Unity

• When this is checked, selecting Trim or Touch 
mode causes the faders to jump to unity posi-
tion.

• When Trim From Unity is not checked, the 
faders remain at their current positions. Mov-
ing the fader up or down adds or subtracts the 
difference from the automation data recorded 
for that channel.

Faders

• This readies the automation computer to record 
all fader movements for any write-enabled chan-
nel.

Pans

• This readies the automation system to record all 
pan movements for any write-enabled channel.

• All surround pans are recorded as well as L/R 
positioning. However, surround output, depth of 
center, and LFE Level are not written with this 
selection (use Other/All to write automation for 
these parameters).

Mutes

• This readies the automation computer to record 
all mute activity for any write-enabled channel.

Other

• Selecting Other mirrors the ALL button on the 
console.

• Sets the automation computer to record all pa-
rameter changes for the write-enabled channels, 
other than the individually selectable Faders, 
Mutes, and Pans.

Filter

• Opens the Automation Filter window. This 
allows you to select individual parameters for 
automation from a list of available parameters 
other than Faders, Mutes, and Pans.

• Parameters include Auxes, EQs, Dynamics, 
Buses, Phase, and Misc (everything else).
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Latch

• This determines the action of overwriting auto-
mation data during a pass.

• When Latch is selected, automation data for 
the selected parameter begins to be overwritten 
as soon as the parameter’s control is adjusted 
and continues to be overwritten throughout a 
pass, even if the parameter’s control ceases to 
change.

• When Latch is off, automation data for the 
selected parameter begins to be overwritten as 
soon as the parameter’s control is adjusted, but 
as soon as the parameter’s control stops chang-
ing, the subsequent automation data is left 
intact.

Touch Timeout

• When Latch is off, the Touch Timeout control 
determines the amount of time between when 
the control stops moving and when automation 
stops writing data for that parameter.

• The range for Touch Timeout is 0 ms to 5000 
ms (5 sec).

Write Flyback

• This determines what happens to the parameter 
levels upon punch-out of automation record.

• When Write Flyback is selected, each param-
eter recorded into automation returns to its 
previously adjusted status at the end of a record 
pass. A track that was off for an entire ar-
rangement snaps back to off, after the level is 
increased, when punched out of write-record.

• When Write Flyback is off, parameter adjust-
ments in automation remain at their last 
user-adjusted setting, even after the end of the 
automation pass.

Return Time

• When Write Flyback is selected, the Return 
Time control determines the amount of time 
between when the control stops moving and 
when automation stops writing data for that 
parameter.

• The range for Return Time is 0 ms to 5000 ms 
(5 sec).

Snapshots (Ctrl+2)
A snapshot is just what its name implies. It is a 

snapshot of all the settings on the console that is 
stored in memory for later recall.

New

• To create a new snapshot, click the New button.

• Each new snapshot is automatically given a 
number and the name “Snapshot.”

• To change its name, double-click on “Snapshot,” 
then type the new name. Press ENTER on the 
keyboard to complete the naming procedure. 
Or touch the name “Snapshot” to highlight it, 
then touch it again to open the on-screen key-
board. Type the new name, then touch ENTER 
on the keyboard.

• Double-click in the Description column of the 
snapshot to enter a text description.

Edit

• Select a snapshot, then touch the Edit button to 
open the Snapshot Filter window.

• The Snapshot Filter window allows you to fi lter 
out certain parameters so they do not get over-
written when the selected snapshot is recalled.

• You can also exclude certain channels from being 
overwritten when the selected snapshot is recalled.

Delete

• Select a snapshot, then touch the Delete button 
to remove it from the snapshot list.

• If the snapshot is locked, it cannot be deleted.

• This cannot be undone. Once you delete a snap-
shot, it is gone forever.

Recall

• Select a snapshot, then touch the Recall button to 
overwrite all the parameters (or selected param-
eters from the Snapshot Filter window) on the 
Digital X Bus with those stored with the snapshot.

• You can also double-click (or double-touch) on 
the snapshot number to recall it.
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• To update and overwrite an existing snapshot, 
select the snapshot, then touch the Store button 
to overwrite the snapshots with the new settings.

Menu

• The drop-down menu list duplicates the New, 
Recall, Store, Edit, and Delete buttons in the 
Snapshot window.

• In addition, it allows you to Lock and Unlock 
a snapshot. When a snapshot is locked, as in-
dicated by the closed lock icon in the snapshot 
list, it cannot be deleted or overwritten.

• The Renumber option renumbers the snapshot 
list in consecutive ascending numerical order.

Locator (Ctrl+3)
The Locator window contains transport controls, 

and allows you to create new locate points.

Transport Controls

• The transport controls operate any connected 
record or playback devices using MIDI Machine 
Control (MMC) via the MIDI port.

• These controls mirror the transport controls 
on the control surface and include Return to 
Zero (not on the control surface), Rewind, Fast 
Forward, Stop, Play, and Record.

Numeric Transport Position Indicator

• This window display time code in either SMPTE 
or BBT (Bars/Beats/Ticks), depending on what 
is selected in the Mix Editor drop-down menu.

• This mirrors the time code readout in the upper 
right corner of the touchscreen.

 Ways to Enter Locator SMPTE Position:

• Double-click in the desired fi eld (Hours, Min-
utes, Seconds, Frames) and click and hold in 
the upper half of the fi eld to scroll the number 
up, or click and hold in the lower half of the 
fi eld to scroll the number down.

• Double-click in the desired fi eld and enter the 
number from the keyboard. Press Enter to 
complete. Or touch the desired fi eld to open the 
numeric keypad on-screen, enter the number, 
and touch Enter to complete.

• Press the SET button (in the Transport Sec-
tion on the control surface) then enter a locate 
time using the numeric keypad on the control 
surface. Press ENTER to complete.

New

• Click this button to create a new locate point.

• The new locate point is created at the current 
time code position.

• Each new locate point is automatically given a 
number and the name “Locate.”

Delete

• Select a locate point, then touch the Delete but-
ton to remove it from the locate list.

• This cannot be undone.

Rename

• To rename a locate point, select it and then 
touch Rename. This highlights the name 
(Description) of the locate point. Type the new 
name from the keyboard, then press Enter (on 
the keyboard) to complete the naming proce-
dure. 

• Another method is to touch the name “Locate” 
to highlight it, then touch it again to open the 
on-screen keyboard. Type the new name, then 
touch ENTER on the keyboard.

Renumber

• Touch the Renumber button to renumber the 
locate points in consecutive ascending numeri-
cal order.
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Store

• To reassign an existing locate point, select the 
locate point, then touch the Store button to re-
assign the locate point to the current time code 
position.

Locate To

• To move to a locate point, select the locate 
point and touch Locate To.

• You can also double-click on the locate point 
number to move the timeline cursor to the 
locate point position.

Equalizer (Ctrl+4)
This opens the Equalizer window for the selected 

channel.

ON Button

• This is an On/Off button, located at the top of 
the Equalizer window. It works as an EQ bypass 
switch, so you can easily make an A/B compari-
son of the sound with and without EQ.

Memory A/B

• Each memory stores the most recent EQ set-
tings made for the selected channel.

• Click either of these buttons to instantly recall 
the stored settings.

• Ideal for making quick A/B comparisons be-
tween EQ settings.

MORPH

• Click the MORPH button to smoothly fade 
from one memory setting to the other (Memory 
A and B).

• The amount of time it takes for this transition 
is set in the time window next to the MORPH 
button.

• Morph time can be set as low as 0.1 second or 
as high as 30 seconds.

MENU

• Click the MENU button to Cut, Copy, and Paste 
the EQ settings to and from the clipboard.

• Select Reset to return all the EQ controls to 
their default settings.

• Select EQ Presets to open the EQ Presets 
window. Here you can save or load preset EQ 
settings from the presets directory.

Each band of the 4-band EQ has:

• An On/Off button for the individual band.

• EQ Type Select: Click on the EQ type pop-up 
box to select from Low Shelf, High Shelf, Peak-
ing, Low Pass, and High Pass.

• Gain, Freq, and Q controls. These are adjusted 
using the V-Pots just below the controls on-
screen. Note that when High Pass or Low Pass 
are selected, the Gain control has no effect.
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This opens the Dynamics window for the selected 
channel, which contains controls for the Compres-
sor and Gate.

ON Button

• The compressor and gate each have an On/Off 
button, located at the top of their respective dis-
plays. It works as a bypass switch, so you can 
easily make an A/B comparison of the sound 
with and without compressor and gate.

Memory A/B

• Each memory stores the most recent settings 
made for the selected channel.

• Click either of these buttons to instantly recall 
the stored settings.

• Ideal for making quick A/B comparisons be-
tween settings.

MENU

• Click the MENU button to Cut, Copy, and Paste 
the compressor and gate settings to and from 
the clipboard.

• Select Reset to return all the compressor or 
gate controls to their default settings.

• Select Comp Presets or Gate Presets to open 
the Presets window. Here you can save or load 
preset compressor or gate settings from the 
presets directory.

Compressor

A compressor is used to reduce or limit transient 
peaks in a signal. As the input level to the compres-
sor increases, the output level increases linearly 
until the threshold point is reached. After that 
point, the output level no longer increases linearly. 
Instead, it increases at a reduced rate determined 
by the ratio setting.

The compressor is represented graphically by a 
diagonal line across an X-Y coordinate display. The 
horizontal axis represents the input signal level to 
the compressor, and the vertical axis represents 
the output signal level from the compressor. When 
the compressor is not acting upon the signal (below 
the threshold), the input equals the output and the 
line moves diagonally across the display. When the 
compressor begins acting on the signal, the output 
no longer follows the input signal, but is reduced 
by an amount determined by the Ratio control. The 
greater the ratio setting, the less the output level 
changes as a function of the input level.

There are fi ve controls for the compressor along 
the bottom edge of the window. These are controlled 
by the V-Pots located just below them.

Threshold

• Determines the level at which the compressor 
begins to act on the incoming signal. It is cali-
brated in decibels, ranging from off (–∞) to 0 dB.

Attack

• Determines how fast the compressor reacts 
once the threshold has been exceeded. It is 
calibrated in milliseconds, ranging from 1 ms to 
100 ms (1/10 second).
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Release

• Determines how fast the compressor turns off 
once the signal falls below the threshold. It is 
calibrated in milliseconds, ranging from 10 ms 
to 1000 ms (1 second).

Ratio

• Determines the change in output level as a 
function of the change in input level, once the 
threshold has been exceeded. The Ratio control 
ranges from 1.00:1 to 20.00:1. Thus, if the ratio 
is 10:1, an increase in input level of 10 dB (as-
suming the input is above the threshold level) 
results in a 1 dB increase in output level.

• When set to 20:1, the compressor acts as 
a peak limiter. After the initial attack time, 
the output changes very little once the input 
crosses the threshold.

Output

• Determines the amount of makeup gain applied 
after the compressor. Use this control to com-
pensate for the loss of gain caused by the action 
of the compressor. It is calibrated in decibels, 
ranging from unity (0.00 dB) to +20.00 dB.

Soft

• This button turn on the compressor soft knee 
function. The knee of the compressor describes 
the point on the input-output graph where the 
threshold begins to reduce the output.

• A hard-knee compressor means that, up until 
the moment the input signal crosses the thresh-
old, no compression occurs. Once the threshold 
is crossed, the full ratio of gain reduction is 
applied to the input signal (assuming the attack 
time has passed).

• With the soft knee engaged, the gain reduc-
tion begins to occur before the input signal 
reaches the threshold. The amount of reduction 
gradually increases until the full ratio setting is 
reached slightly after the threshold is crossed. 
This can be seen as a curve around the knee 
point on the compressor graphic display.

Meters

There are three vertical bars to indicate metering 
for the compressor. One indicates the input signal 
level entering the compressor (IN), one indicates 
the output signal level leaving the compressor 
(OUT), and one indicates the amount of gain reduc-
tion being applied to the signal (R). The gain reduc-
tion meter indicates from the top to the bottom, 
starting at 0 dB (no gain reduction), and moving 
down as the compression increases.

Note that the meters indicate compressor function 
only, and do not indicate the closing or opening of 
the gate.

Gate

A gate is used to duck or mute a channel when 
the signal level drops below a certain point. This 
can reduce the overall noise level in your mix by 
muting unused or noisy channels. 

The gate is represented graphically by a diagonal 
line across an X-Y coordinate display. The horizontal 
axis represents the input signal level to the gate, 
and the vertical axis represents the output signal 
level from the gate. When the input signal level is 
below the threshold setting for the gate, there is 
no output and the red indicating LED in the gate 
window lights. When the input signal level is above 
the threshold, the signal passes through the gate 
unaffected.

There are fi ve controls for the gate along the bot-
tom edge of the window. These are controlled by the 
V-Pots located just below them.

Note: When we say the gate opens, it means the 
gate is not acting on the signal and the signal is 
allowed to pass. When the gate closes, the gate 
acts on the signal by attenuating it.

Threshold

• Determines the level at which the gate acts on 
the incoming signal. It is calibrated in decibels, 
ranging from off (–∞) to 0 dB.

Attack

• Determines how fast the gate opens once the 
threshold has been exceeded. It is calibrated in 
milliseconds, ranging from 0.1 ms to 100 ms.

Hold

• This determines how long the gate remains 
open after the input signal has fallen below, and 
remains below, the threshold before closing. It 
is calibrated in milliseconds, ranging from 20 
ms to 1000 ms (1 second).

Release

• Determines how fast the gate closes after the 
hold time has expired, once the signal falls 
below the threshold. It is calibrated in millisec-
onds, ranging from 10 ms to 1000 ms (1 sec-
ond).
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• Determines the amount of gain reduction ap-
plied to the signal once the signal level drops 
below the threshold. It is calibrated in percent, 
ranging from 0% (no attenuation) to 100% (full 
attenuation).

Key (Trigger) Input

• Uses the signal from another source to trigger 
the dynamics for a channel.

• Click the drop-down box to select the key input 
source.

•   Touch the EQ window 
below the drop-down box to 
turn on the key input EQ (the 
background of the EQ graph 
lights).

•   The key input EQ fi lters 
the key input signal prior to 
triggering the gate. It is a 
peaking fi lter, and allows you 
to tighten the trigger signal to 
a narrow band of frequencies.

•   There are two controls for 
the key input EQ, Frequency 
and Q. Use the V-Pots below 
the graphic representation 
of the knobs to adjust the 
controls.

Surround (Ctrl+6)
The SURROUND window offers precise control 

over image positioning in any mixing panorama 
along with individual subwoofer level and depth of 
center control.

Surround position control is available from the 
control surface by using the individual channel PAN 
L/R and PAN F/B V-Pot controls.

Global Surround Mode

• Click the drop-down box to select the surround 
mode. The choices are Stereo (default), Quad, 
LCRS, 5.1, 7.1 (SDDS), and 7.1 (TP).

• Changing the surround mode changes the posi-
tion of the speaker icons in the surround panner 
display.

• The surround outputs are automatically as-
signed to the Bus 1-8 outputs. Click the buttons 
in the Surround Bus Assigns section to assign 
the surround signals from the selected channel 
to the bus outputs (duplicates the bus assign-
ments in the Assign window).

Surround Panner

• Simply click and drag the ball in the surround 
panner display to move the source location of 
the signal within the surround panorama. The 
top of the display represents the front speakers, 
and the bottom of the display represents the 
rear speakers and the subwoofer.

• The subwoofer is not affected by pan. Its signal 
is tapped prior to the surround panning.
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LFE (Low-Frequency Effects)

• The LFE feature makes it possible to handle 
all your bass management functions right from 
the channel panning, rather than purchasing an 
external surround bass management box.

• Click the LFE Cutoff ON button to turn on the 
LFE channel (subwoofer). When the button is 
off, there is no output to the subwoofer channel 
(Bus 4) and all the low-frequency information is 
routed to the main surround speakers.

• When the LFE Cutoff button is ON (lit), the low-
frequencies are routed to the subwoofer output. 
Rotate the LFE Cutoff knob to select the cutoff, 
or crossover, frequency for the subwoofer out-
put. It ranges from 20 Hz to 8 kHz.

• Rotate the LFE Level knob to adjust the sub-
woofer level. It ranges from 0 dB (unity gain) to 
off (–∞).

Center %

• This controls the amount of center channel 
signal going to the center channel output.

• At 0%, all the center channel signal is routed to 
the center channel output (Bus 3).

• At 50%, the center channel signal is evenly 
distributed among the L, C, and R outputs.

• At 100%, the center channel signal is routed 
to the Left and Right outputs (phantom center 
channel).

Memory A/B

• Each memory stores the most recent settings 
made for the selected channel.

• Click either of these buttons to instantly recall 
the stored settings.

• Ideal for making quick A/B comparisons be-
tween settings.

MENU

• Click the MENU button to Cut, Copy, and Paste 
the surround settings to and from the clipboard.

• Select Reset to return all surround controls to 
their default settings.

MORPH

• Click the MORPH button to smoothly fade from 
one memory setting to the other (Memory A and 
B).

• The amount of time it takes for this transition 
is set in the time window next to the MORPH 
button.

• Morph time can be set as low as 0.1 second or 
as high as 30 seconds.

Auxes
The AUXES window allows you to see all the Aux 

sends settings for the selected channel.

• You can also open the AUXES window by click-
ing the Aux sends section on a channel strip.

• Click the ON button to turn individual Aux sends 
on and off without changing the gain settings.

• Click the PRE buttons to change the Aux sends 
from post-fader to pre-fader.

• Click the MONO/STEREO buttons to toggle 
between mono and stereo pairs.

• Click the MENU button to Cut, Copy, and Paste 
the Aux send settings to and from the clipboard.

Assigns
The ASSIGNS window is perhaps the most power-

ful feature of the Digital X Bus, for it is here that 
you select the input source, multiple insert points, 
and outputs for a channel. You will come to appreci-
ate the power and fl exibility of the signal routing 
capability of the Digital X Bus.

• You can also open the ASSIGNS window by 
touching the assign section on a channel strip.

Input Src

• Click the Input Src (Source) drop-down box to 
select the signal source that is routed to the 
input of the selected channel strip. Typically, you 
would choose an input from one of the I/O cards 
that you have installed. However, you can select 
from a number of other sources including another 
channel, an aux send, one of the eight buses, the 
talkback mic, or one of three built-in oscillators 
(oscillator setup is in the Audio Toolbox under 
Windows > Tools).
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Floating Insert Send

• Click the Floating Insert Send drop-down box 
to select where to send the channel’s fl oating 
insert send. You can use any I/O card’s output. 
Typically, you would use this to send the signal 
to an external processor, and return the signal 
to the channel using the Floating Insert Return.

Floating Insert Return

• Click the Floating Insert Return drop-down 
box to select where to return the fl oating insert 
signal. You can use any I/O card’s input.

Phase Reverse

• Click the Phase Reverse button to invert the 
polarity of the signal by 180º.

Digital Trim

• The Digital Trim allows you to adjust the input 
level just after the A/D converter and before the 
channel DSP.

• Provides a method to trim the input signal when 
using Digital I/O cards.

Delay

• Adds delay to the selected channel. Ranges 
from 0 ms to 500 ms. This can be manually ad-
justed with the V-Pot, or automatically adjusted 
when using the “Adjust Channel Delay” feature 
(Channel > Adjust Channel Delay).

Bus Assigns

• Click the Bus Assigns buttons to assign the 
output of the channel strip to Bus 1-8 and the 
L-R bus.
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Pre Insert

• The Pre Insert point is located just before the 
channel DSP section.

• Used to insert a plug-in effect into the channel, 
pre-DSP.

• Click the Pre Insert drop-down box to select a 
plug-in from the available effects in the Effects 
Rack.

Note: One or more plug-ins must be installed in the 
Effects Rack (Ctrl+8) before a Pre Insert can be 
selected or None will appear in the drop-down box.

• If it’s a stereo effect, a channel can be assigned 
to the left or right input of the effect.

• The corresponding output of the effect is re-
turned to the channel’s Pre Insert point.

Post Insert

• The Post Insert point is located just after the 
channel DSP section.

• Used to insert a plug-in effect into the channel, 
post-DSP.

• Click the Post Insert drop-down box to select a 
plug-in from the available effects in the Effects 
Rack.

Note: One or more plug-ins must be installed in the 
Effects Rack (Ctrl+8) before a Post Insert can be 
selected or None will appear in the drop-down box.

• If it’s a stereo effect, a channel can be assigned 
to the left or right input of the effect.

• The corresponding output of the effect is re-
turned to the channel’s Post Insert point.

Direct Output

• The Direct Output is located after the channel 
DSP and just before the fader, mute, and pan 
controls.

• Click the Direct Output drop-down box to assign 
the selected channel’s Direct Output to the 
output of any I/O card.

Direct Out Level

• The Direct Output Level control corresponds 
to the LEVEL TO TAPE V-Pot control on the 
console surface (T-OUT). It ranges from off (–∞) 
to +10 dB.
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The MIX EDITOR window contains a graphic 
representation of automation data. Though automa-
tion data is primarily entered through the control 
surface knobs, buttons, and faders, it can also be 
altered graphically in the Mix Editor. Precise level 
and timing information is easily entered and adjust-
ed here. The window supports various selectable 
views from 1 to 30 channels, or parameters, of data 
on the Y axis and any length of time region on the 
X axis (up to 24 hours). A vertical scroll bar allows 
for paging or incremental viewing of the channels 
or parameters, and the horizontal scroll bar allows 
for paging or scrolling time chunks, according to the 
current time resolution. Click and drag the edge of 
the scroll bar to increase and decrease the resolu-
tion in the horizontal or vertical direction (dupli-
cates the function of the left/right and up/down 
arrows in the upper left corner).

The Mix Editor can view a single channel with 
all of its parameters or, by selecting the channel 
in the Show drop-down box, or you can view mul-
tiple channels of one parameter type by selecting 
All Channels and the parameter type in the second 
Show drop-down box.

Automation Event curves are displayed as dots 
(actually, small squares) that represent nodes, and 
lines that represent value ramping. The nodes rep-
resent editable points that are either created during 
the automation process in real time, or by the Pencil 
tool in the Mix Editor.

On/Off or radio button-type parameters (e.g., 
Mutes, EQ On/OFF, or Bus Assign) that aren’t of a 
ramping type are displayed as stepped values.

Event markers appear in the Mix Editor’s time 
bar, and can be dragged forward or backward.

Automation tracks may be cut, copied, and pasted 
in typical graphic editor fashion, using click and 
drag highlighting with mouse cursor and the I-Beam 
tool (highlighter). Single segment copy and multiple 
pasting may be performed easily with repeatable 
segments for a “groove” repetition approach. An 
entire time region across all parameters or channels 
(according to the current view) may be selected by 
clicking and dragging across a region with either a 
single channel or All Channels selected. Highlighted 
regions may be “nudged” up, down, left, or right for 
trim or offset needs, using the four nudge arrows.



47Owner's Manual

O
w

n
e

r's M
a
n

u
a
l

MENU

• Click the MENU 
button to Cut, Copy, 
and Paste the selected 
region to and from the 
clipboard.

• The Tool submenu 
allows you to select 
one of the editing tools 
(I-Beam, Pencil, Eraser, 
or Magnify). These tools 
can also be selected by 
clicking their icons in 
the bottom left corner of 
the Mix Editor.

• The Time Format 
submenu allows to 
choose either SMPTE 
or BBT formats for the 
time format displayed 
in the time bar and the 
time code readout in the 
upper right corner of the 
right touchscreen.

• The Nudge submenu allows you to nudge a 
selected node or nodes up, down, left, or right. 
The nudge values are selected in the NUDGE 
window (click the Nudge icon with the four ar-
rows at the bottom of the Mix Editor).

• The Scrolling submenu allows you to choose 
how the timeline cursor behaves while time 
code is rolling.

 With Auto-Scroll selected, the timeline cursor 
scrolls until it reaches the center of the screen, 
and then the screen scrolls past the timeline 
cursor while it remains centered.

 With Page-Flip selected, the timeline cursor 
scrolls to the right side of the screen and then 
jumps back to the left side while the screen 
fl ips to the next page.

 When None is selected, the screen does not fol-
low the timeline cursor.

 When Follow Selected Channel is checked, 
when a single channel is selected in the View 
box, the channel displayed in the Mix Editor 
follows the channel selected with the SELECT 
button.

• Select Insert Time to insert a region of no data 
change at the start point of a selected region. 
The amount of time inserted is equal to the time 
of the selected region.

• Select Delete Time to delete a selected region of 
data.

• Play From Selection starts playback of automa-
tion from the time entered in the Start Time 
window at the top of the Mix Editor. The start 
time is the beginning of a selected region, or the 
time at which the playback cursor is located.

Show

• These drop-down boxes allow you to select 
individual channels to display in the Mix Editor, 
or individual parameters across all channels.

• Click the Empty box to clear the Mix Editor 
from displaying any automation data.

Start Time/End Time

• These boxes display the start time and end time 
of a selected region for editing. 

• When a region is selected, markers appear in 
the time bar named Edit In and Edit Out at the 
start time and end time.

Cursor/Value

• The Cursor box displays the time position of the 
mouse cursor as it moves around the Mix Editor 
screen.

• The Value box displays the corresponding value 
of the cursor’s position. Useful for editing auto-
mation data.

Zoom Arrows

• The four arrow at the top of the channel/
parameter list expand and contract the time 
axis (left and right arrows) and change the dis-
played number of automation tracks or param-
eters (up and down arrows) when clicked.

Edit Tools

Click on the edit tool icons at the bottom of the 
Mix Editor screen to select them.

I-Beam Tool (Highlighter)

• Use this tool to select data by time and channel.

• Click and drag across a the horizontal axis to 
highlight a specifi c time region.

• Click another track name (left column) to move 
the current highlighted region (time segment) 
to the selected track.

• Click and drag across the top timeline bar to 
select a region across all tracks.

Note: You can select multiple adjacent channels 
or parameters by pressing the Shift key on the 
keyboard (or on the console) while clicking on 
track names.
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parameters by pressing the Ctrl key on the keyboard 
(or on the console) while clicking on track names.

Pencil Tool (Hand Tool)

• Use this tool to enter new data nodes and to 
alter existing ones.

• The Pencil tool can create and move new or cur-
rent automation nodes while time code is being 
received (on the fl y editing—before or to the 
left of the current time) or while time code isn’t 
being received (at any point on the timeline).

Eraser Tool

• Use this tool to remove automation data. Click 
on a node to remove it.

Magnify Tool

• Use this tool to select specifi c data lengths and 
to expand the data time to fi ll the screen.

• Click and drag with the Magnify tool to zoom 
into a specifi c area.

• Hold the Ctrl key while in magnify mode to 
zoom out.

Auto Scroll

• The right pointing arrow button next to the 
Magnify tool toggles Auto Scroll on and off.

• You can toggle Auto Scroll while time code is 
running.

Nudge Arrows

• Click the Nudge Arrows button to open the 
NUDGE window.

• You can move, or nudge, a selected region by an 
amount indicated in the NUDGE window.

• You can select the nudge time (horizontal axis) 
for nudging a selected region left and right by 
entering a value in the box between the Left 
and Right buttons. Click the box to open the 
numeric entry window.

• You can select the nudge amount (vertical axis) 
for nudging a selected region up and down by 
entering a value in the box between the Up and 
Down buttons. Click the + and – buttons to 
change the nudge amount, or click the box to 
open the numeric entry window. You can enter a 
value from 1 to 100.

Delete, Cut, Copy, Paste Buttons

• These buttons perform the same editing func-
tions that appear in the Mix Editor menu.

• The editing function are applied to a selected 
region, highlighted between the Edit In and Edit 
Out markers.
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Effects Rack (Ctrl+8)
The EFFECTS RACK window is where you select 

the plug-ins you want to use in your session. The 
Digital X Bus comes with a variety of plug-ins, 
ready to use. In addition, you can install any VST 
plug-in, a fi rst for any digital mixing console in this 
class.

You can select multiple plug-ins to use as internal 
effects processors for inserting into a channel’s pre 
or post insert point, or to drive with an Aux send 
(and return via an unused channel).

New Plugin

• Click this drop-down box to select a plug-in to 
add to the Effects Rack.

• Each plug-in has a drop-down box to select an 
input source. If it’s a stereo effect, it has sepa-
rate input source selection boxes for the left 
and right inputs.

• Each plug-in has an ON button, Memory A and 
B, and a Menu drop-down for cut, copy, paste, 
and saving and loading presets.

• Click the right-pointing arrow in the upper left 
corner of the plug-in to open the controls for the 
particular effect. Some plug-ins have a GUI but-
ton to open a separate window with a custom-
ized user-interface.

• The controls for the selected plug-in also ap-
pear at the bottom of the EFFECTS RACK win-
dow so you can use the corresponding V-Pots to 
adjust the parameters.

• You can select a particular plug-in more than 
once. For example, if you want to have a reverb 
effect on channel 1 and channel 2, select the 
Reverb plug-in twice in the New Plugin drop-
down box. They will appear as Reverb 1 and 
Reverb 2.

Delete Plugin

• Click this drop-down box to select a plug-in to 
remove from the Effects Rack.

• Deleting a plug-in from the Effects Rack auto-
matically removes it from its input source and 
output destination.

Running

• Indicates that the system is operating smoothly 
with no overloading to the processor.

Usage

• This indicator shows how much of the available 
processing power is being used by the plug-ins 
loaded into the Effects Rack. The more effects 
you load into the Effects Rack, the higher the 
usage indicator will go.

MIDI Map (Ctrl+9)

The MIDI Map window offers setup options for 
bidirectional MIDI control of practically the entire 
console’s parameter set. The MIDI Map provides 
complete parameter access to almost all channel 
functions, master fader, channel strip, and Aux 
master controls, and all plug-in parameters. In addi-
tion, the Master section and Transport controls are 
assignable to MIDI messages.

MIDI continuous controller, polyphonic after-
touch, and note on messages are assigned to the 
various parameters via the MIDI Map, in a linear 
approach of one controller type per parameter. Any 
variable controller may be a continuous control mes-
sage or a poly aftertouch message, and any switch 
message (on/off assignment switches) can be as-
signed to a note on (or note off as note on of veloc-
ity 0) message.

Messaging may be bidirectional. This means you 
can control the console from a sequencer or control 
a sequencer from the console. Note that MIDI pro-
gram changes may also be used to trigger Digital X 
Bus snapshots. Snapshot program change messages 
may occur simultaneously with MIDI Map control 
messaging. 
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transport control from MIDI applications that don’t 
support MMC or the HUI protocol (but do allow 
their own internal parameter mapping), surround 
joystick control, or any continuous controller or 
two-state switch application (lighting, remote 
mixing, show controls, etc.) Any mapped control 
information may be transmitted via manual adjust-
ment on the console, snapshot recall, and automa-
tion playback (which may include snapshot or other 
Event track playback).

Menu

New MIDI Route

A route is made up of the following attributes:

• Selection: The fi rst column (with no column 
heading) denotes the route number and selected 
route within the map list. The number is a 
simple identifi er, as there is no sorting mecha-
nism for the MIDI routes.

• MIDI Type: This choice offers the type of MIDI 
message. If the route is mapping a switch 
parameter with two value states, it will be as-
signed as a Note message. If the parameter is 
continuously variable, the Controller or After-
touch types may be used.

• Number: This assignment is in the range of 
0-127 decimal values for the associated MIDI 
Type.

• Channel: This is the MIDI channel that is used 
for the selected route.

 Note: Maps using Ch 1 will not function when 
DAW Emulation mode is enabled. If you are us-
ing a DAW Emulation, use only channel 2-16 for 
MIDI routes.

• Route To/From: This assigns the MIDI route to 
a console channel strip, Aux master, Bus mas-
ter, Group, MIDI channel (Groups bank), DAW 
channel (MIDI bank), or Left or Right Master. 
The actual parameter within any chosen func-
tion is assigned in the Parameter column.

• Parameter: Available choices follow whether 
switch or variable control is selected under 
MIDI Type.

• Mode: The Mode option is enabled when Note 
is selected as the MIDI Type. The two options 
available are Normal and Toggle. These refer to 
how the switch responds to received MIDI data 
and is therefore only relevant if the Direction is 
set to Receive.or Both.

 In Normal mode, a Note On message engages 
the switch and a Note Off (or Note On with 
velocity of zero) disengages the switch.

 In Toggle mode, alternating Note On messages 
engage and disengage the switch, while Note 
Off messages are ignored.

• Direction: The MIDI route is set to Receive, 
Send, or Both. Take care to avoid MIDI feed-
back.

Open MIDI Map…

• Recalls a saved MIDI Map from disk. If a map 
is currently in place, it well be entirely overwrit-
ten by the map from disk upon loading.

Save MIDI Map As…

• Saves the current MIDI Map to disk as a Map 
fi le, which is available for recall at a later date.

Delete MIDI Route

• Deletes the currently selected Route(s) within 
the list.

DAW Bank
Selecting DAW Bank under the Windows menu 

switches to the DAW Bank (MIDI). This bank 
allows you to control a number of DAW software 
applications with the Digital X Bus. Select the DAW 
application of your choice in the Emulation Mode 
drop-down box. The on-screen buttons and V-Pots 
map to the selected DAW application, simplifying 
your ability to work with the Digital X Bus and the 
DAW at the same time.

I/O Confi guration (Ctrl+0)
The I/O Confi guration window allows you to select 

the various cards you have installed in the card 
cage and customize their I/O confi gurations and 
other settings for your session.

When the I/O Confi guration window opens, you 
see a graphical representation of all the cards 
installed in the card cage. Click a card to open the 
setup window for that card. Depending on the card, 
the options available will differ. Generally, for I/O 
cards, you can rename the inputs and outputs, as-
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sign the output sources to virtually any signal path 
in the Digital X Bus, and confi gure other parameters 
specifi cally related to the card.

The Mix Card setup allows you to select the out-
put source for AES/EBU, Phones 1 and 2, Mix Out, 
and Speaker Out 1 and 2.

The Sync Card setup has options for Sample 
Clock, Sample Rate, Time Code Source, Frame Rate, 
Clock In Adjust, and Clock Out Adjust.

Tools Submenu
There are two choices in the Tools submenu, Au-

dio Toolbox and System Info.

Audio Toolbox (Ctrl+T)

The Audio Toolbox has a built-in spectrum ana-
lyzer, and setup for three built-in oscillator sources.

The spectrum analyzer allows you to view the 
spectral characteristics of a signal in real time, 
where the horizontal axis represents frequency and 
the vertical axis represents amplitude. There are 
two inputs to the spectrum analyzer, so you can 
select different sources for the two inputs (Input 1 
and Input 2 drop-down boxes) and compare their 
spectral content. For example, you might want 
to compare the left and right sides of a fi nal mix 
to confi rm that their overall frequency responses 
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window types for displaying the spectral readout, 
including Rectangular, Bartlett, Hamming, and Han-
ning. Click the Freeze button to catch a particular 
instance on-screen for closer examination.

The three oscillators have identical controls 
including On/Off, Volume, Frequency, and Waveform 
Type (Sine, Triangle, Saw, Square, White Noise, 
Pink Noise). Each of these oscillators can be se-
lected as an input source for any channel.

System Info

The System Info window gives you an overview 
of system resources in real time. DSP CPU Usage 
and DMA Load are displayed in percentages, along 
with other esoteric numbers including the measured 
sample rate and I/O latency.

Applications
Setting Up For a Session

This section of the X.200 Owner's Manual pro-
vides very application-specifi c descriptions of some 
common usages. As your skills and knowledge 
increase, try new techniques. Build a system that's 
optimized for your specifi c application.

Listening Environment

In any serious recording situation, the listening 
environment is one of the most important consid-
erations. Be sure the Digital X Bus is connected 
to excellent reference monitors, like the Mackie 
 HR824s. In addition, set up the system in an acous-
tically controlled and balanced environment. Avoid a 
control room with identical dimensions in any direc-
tion and set it up with a good mixture of absorption 
and refl ection.

When mixing in stereo or surround, select the 
best location—typically called the “sweet spot”—to 
critically assess the entire mix. Eliminate guess 
work. Maximize effi ciency.

Channel Confi guration/Planning

This actually has a lot to do with how well any 
audio experience unfolds. If you know where you’re 
headed with track expectations and instrumenta-
tion, you’ll be able to make better choices along 
the way. Plan; plan again; think about it; then, plan 
some more.

Devise a mock-up of the fi nal track sheet to plan 
your session before you begin recording. You’ll 
know more about how to get where you want to be.

Installation and Connection of 
Optional I/O Cards

The Input/Output cards are an essential part of the 
Digital X Bus multitrack system. There are several 
optional cards available for the X.200, which you 
can install into the card cage in the rear panel of the 
console. These cards provide up to 72 inputs and 
outputs for use with any common analog and digital 
formats.

Since the  I/O cards are optional and interchangeable, 
you need to install them before you begin creating hit 
recordings. Refer to “Connections” on page 9 for an in-
depth review of the various I/O cards available.
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Anti-Static Precautions

The Digital X Bus I/O cards come 
packaged in an anti-static bag for 
protection against electro-static 
discharge (ESD). Do not remove the 

card from the bag until the exact moment you are 
ready to install it. When the time comes to remove 
the card from the bag, take great care to hold it by 
the rear metal plate only. Never touch the circuit 
board, its electronic components, or input/output 
connectors. Do this procedure in an area that is not 
carpeted.

 You are probably getting anxious to install the card, 
but count to ten, and read these instructions fi rst.

Installation Procedure

You will need a medium-size slot-head screwdriver.

1. Turn the power off and remove the power cord 
and all other cords from your Digital X Bus.

2. Place the Digital X Bus on a fl at horizontal 
surface, where you can easily access the rear 
panel.

3. Use the screwdriver to undo two screws and 
remove any unused plate from card slots A, B, 
or C. Keep the plate in a safe place as you may 
need it one day.
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Note: Do not remove or reposition the two cards 
that come with your Digital X Bus. The D-slot is 
not used on the X.200, and is described in the 
Digital X Bus X.400 manual.

4. Now is the time to install the new card. Move 
the bag containing the card close to the Digital 
X Bus. Touch your hand against any exposed 
metalwork of the Digital X Bus, as this will help 
remove any excess static. Without taking any 
footsteps, remove the card from its anti-static 
bag. Take great care to hold it by the rear metal 
plate only. Never touch the circuit board, its 
electronic components, or input/output connec-
tors.

5. Gently slide the card in place, making sure that 
the top and bottom edges align with the nylon 
runners of the Digital X Bus. The card should 
just gently slide in place until the last quarter 
of an inch, then you can press gently, but fi rmly 
against the metal plate until the card is fully in 
place. Do not press against any input or output 
connectors. Finger-tighten the screws to secure 
the card.
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6. The Digital X Bus is now ready to take its place 
in polite audio society, and your job here is 
done. Gather 50 good friends and tap-dance out 
into the street, taking care to follow all road 
safety rules and tap-dance instructions.
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You can install the optional I/O cards in any of the 
slots labeled A, B, or C, in any combination to suit 
your particular application. You can confi gure the 
cards in the I/O Confi guration window (Windows > 
I/O Confi guration).

Refer to Appendix B for wiring diagrams of the 
various connectors used on the I/O Cards.

1. MIC/LINE 4 CARD
This card provides four analog mic/line inputs on 

female XLR connectors, and four analog line-level 
inputs on 1/4" TRS connectors, for a total of eight 
analog inputs. Note that this card does not provide 
any outputs.

2. MIC/LINE 8 CARD
This card provides eight analog mic- or line-level 

inputs and eight line-level outputs. Connections are 
made through two 25-pin D-Sub connectors.

3. LINE CARD
This card provides eight analog line-level inputs 

and outputs. Connections are made through two 25-
pin D-Sub connectors.

4. DIGITAL CARD
This card provides eight digital inputs and eight 

digital outputs. Connections are provided in both 
ADAT Multichannel Optical Interface and Tascam 
 T/DIF-1 formats.

The connection for  ADAT is made with a fi ber op-
tic cable, sometimes referred to as “lightpipe.” This 
connection provides eight channels of digital audio. 
You can purchase this cable from your Alesis dealer, 
Monster Cable, Hosa, or other cable manufacturer.

 The connection for T/DIF-1 is made with a 25-pin 
D-Sub connector. This connection provides eight 
channels of bidirectional digital audio. This con-
nection requires a 25-pin D-sub cable (Tascam Part 
Number PW-88D).

5. AES/EBU CARD
This card provides eight digital inputs and eight 

digital outputs in the AES/EBU standard format. Con-
nection is made through a 25-pin D-Sub connector. 

AES/EBU is a standard two-channel digital proto-
col used for long balanced cable applications. Thus, 
each conductor actually transmits two channels of 
digital audio data.

6. FIREWIRE CARD
The FireWire card uses the IEEE-1394 protocol 

for connecting digital devices. It currently provides 
24 inputs and 24 outputs of digital audio at 48 kHz, 
and 8 inputs and 8 outputs at 96 kHz.
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Checklist for Basic Operational 
Functionality

Basic system functionality depends on the ac-
curate selection of a few key items. Work through 
this checklist to verify console settings. The previ-
ous chapters provide an explanation of each item. 
This checklist simply provides a mental road map to 
verify proper functionality.

Input Source
❏ Mic/DI

❏ Line/Instrument

Channel EQ and Dynamics
❏ EQ

❏ Compression

❏ Gate

Signal Routing
❏ To L/R

❏ To Tape

❏ To Bus

Monitor Speaker
❏ Control Room selection correct

Power-up Procedure

A well-thought-out power-up procedure saves 
wear and tear on all your gear. This procedure helps 
minimize the opportunity for equipment damage 
while maximizing the chance of success. Refer to 
Figure 4-1 for a Fast Track Graphic representation 
of this procedure.

❏ Connect Speakers Out A to an amplifi er/monitor 
speakers combination or a pair of powered 
monitors

❏ Amplifi cation system off: power amps or pow-
ered monitors

❏ Master Fader down

❏ Switch Console Power on

 •  The Digital X Bus will load the untitled tem-
plate, which is a Startup fi le with default settings, 
if a user-set  template has not yet been specifi ed.

❏ Open and load a snapshot or a session (optional)

 •  It’s a good idea to keep a snapshot of each 
working confi guration as a starting point: track-
ing, overdubs, symphony, grunge band, etc.

❏ Connect all mics and instruments

 •  Be sure all channel faders are down.

 •  Turn Master Fader down.

 •  Turn Speaker level down.

❏ Set up sample clock

 •  Verify consistent sample rate settings 
throughout all digital multitrack recording 
devices.

 •  Word clock and digital data transfer connec-
tions are very important to the effi ciency and 
functionality of any digital system. Verify them. 

 •  Most systems work best when the Digital X 
Bus is the Master word clock source. Use the 
Sync card to send  word clock to slave devices.

❏ Turn amplifi cation system on

 •  Wait until all other gear is powered up before 
turning on the monitor system.

❏ Enjoy the creative process
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Connect Mix Out Card (Speaker A) 
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Console
Power On

Select a Starting Snapshot (Windows > Snapshots) or
Open Your Master Template (File > New Session)
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AES/EBU
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Figure 4-1  Power-up Procedure



56 X.200

D
ig

it
a
l 

X
 B

u
s Setup Window

The Setup Window (Windows > Setup) is very im-
portant to the functionality of the Digital X Bus. Its 
settings determine how the console operates within 
its own architecture as well as how it interfaces 
with other digital equipment. 

Follow the checklist below to verify that each 
Setup Window parameter is intentionally set. For 
specifi c recommendations for various parameter set-
tings, refer to “Setup” on page 31.

Setup window settings are automatically stored 
and are recalled in subsequent boot-ups.

❏ General

 •  Date and Time

 •  Touch Calibration

 •  Language

 •  Smart Save

 •  Create New Files

 •  Load Last Session at Power-up

❏ Macros

 •  User-defi ned Screen Sets

❏ Mix Options

 •  Surround Mode

• Mixing Options (One Button Record, Record 
Safe, Song Offset, Solo Latch, Use Pre-Roll, 
Pre-Roll time, Meters, Show All Meters, 
Peak Hold, Footswitch Assignment)

❏ MIDI

 •  MIDI File Tempo Map

 •  Default Tempo

 •  MIDI Device ID's

 •  MTC In

 •  MMC Out

 •  MIDI Map In/Out

 •  DAW Main In/Out

 •  DAW Ext 1 In/Out

 •  DAW Ext 2 In/Out

Connecting Input Sources

❏ Install three MIC/LINE 4 or MIC/LINE 8 cards 
into the Digital X Bus A•SLOTS (or whatever 
cards you choose to use for the inputs to the 
Digital X Bus).

❏ Using appropriate cable, connect your micro-
phones and line-level signal sources to the mic- 
or line-level inputs.

 Connecting Analog Multitrack(s)

❏ For 24-track recording, install three LINE cards 
into the Digital X Bus B•SLOTS.

❏ Using the appropriate cable, connect the 25-pin 
D-Sub OUT connectors on the LINE cards to the 
multitrack inputs.

❏ Using the appropriate cable, connect the multi-
track outputs to the 25-pin D-Sub IN connectors 
on the LINE cards.

❏ Make sure all connections are tightly secured.
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 Connecting  ADAT (Lightpipe) 
Multitrack(s)

❏ For 24-track recording, install three DIGITAL 
cards into the Digital X Bus B•SLOTS.

❏ Using fi ber-optic lightpipe cables, connect the 
OPTICAL OUTs A or B on the DIGITAL cards 
to the ADAT digital input connectors on the 
multitrack recorder.

❏ Using fi ber-optic lightpipe cables, connect the 
ADAT digital output connectors on the multi-
track recorder to the OPTICAL INs A or B on 
the DIGITAL card.

❏ If the Digital X Bus is to be the slave, the sync 
source should be connected to the SYNC card 
BNC WORD CLOCK IN and the Sample Clock 
setting should be set to Word Clock (BNC) in 
the I/O Confi guration window (Windows > I/O 
Confi guration > Word Clock Setup).

 Connecting TASCAM ( TDIF) Multitrack(s)

❏ For 24-track recording, install three DIGITAL 
cards into the Digital X Bus B•SLOTS.

❏ Using 25-pin D-Sub digital cables (TDIF), con-
nect the TDIF I/O connectors on the DIGITAL 
cards to the TASCAM MDM (e.g., DA-88) TDIF 
I/O connector.

❏ If the Digital X Bus is to be the slave, the sync 
source should be connected to the SYNC card 
BNC WORD CLOCK IN and the Sample Clock 
setting should be set to Word Clock (BNC) in 
the I/O Confi guration window (Windows > I/O 
Confi guration > Word Clock Setup).

Multitrack Recording 

Multitrack recording involves a continuous as-
sessment of signal fl ow. If you follow a well-planned 
thought process from the beginning of the signal 
path to the end, you’ll succeed in each audio task.

When multitrack recording using the Digital X Bus, 
it’s helpful to visualize the basic signal fl ow between 
fader banks. For any multitrack setup, it’s important 
to keep track of the signal path from the console to 
the multitrack, then from the multitrack back into 
the console. The illustration below is a review dem-
onstrating an important signal fl ow concept.

Work your way though this checklist for multi-
track recording.

❏ Connect input sources to Digital X Bus.

❏ Connect multitrack ins and outs to Digital X Bus.

❏ Follow basic power-up procedure.

❏ Select fader bank 1-24.

Audio Sources
to A•SLOTS

Tracking Out
from B•SLOTS

Multitrack Out
to B•SLOTS

Speaker Out A or B
to Monitors

Multitracks

Fader Bank 1-24
Tracking

Fader Bank 25-48
Mixdown

25-481-24

Figure 4-2  Basic Connection for Multitrack Recording
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assign input sources for each channel used.

❏ Select phantom power button in the Assign 
window for mic inputs if required.        

Note: Condenser mics and active DIs use phantom 
power. Moving coil mics, ribbon mics, and most 
electronic instruments don’t need phantom power.

❏ If using MIC/LINE cards, select –10 dB button 
on channels using line-level inputs.

❏ Assign Fader Bank 1 (Channels 1-24) to Out-
puts 25-48 (Options > Bank to Outputs > Out-
puts 25-48). This routes all 24 inputs on Fader 
Bank 1 to the SLOT•B Outputs going to the 
multitrack recorder(s).

❏ Confi gure Auxes for desired Pre/Post status.

❏ Select Setup (Windows > Setup) and set Mix 
Options.

❏ Test each instrument and mic to verify suffi -
cient level at console input meter.

❏ Adjust input trim (Gain) for a reading around 
–15 on the meter.

❏ Select L/R in the ASSIGN BUTTON SETUP 
section to confi rm Assign lights are on for all 
desired channels, or look on-screen to verify 
that all necessary channels have L/R button 
highlighted in Bus Assign section.

ASSIGN BUTTON
SETUP

REC

READ

WRITE

L - R
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❏ Set Master Fader to Unity position.
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❏ Turn channel faders up to hear instrument or 
mic.
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❏ Once each channel is verifi ed and audible, press 
channel mute.
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❏ Place tape inputs in record/ready to verify sig-
nal at machine. 

It’s typically best to monitor signal from the multi-
track rather than from the channel input.

❏ If levels on the multitrack appear too hot or 
cold, adjust level with the  LEVEL TO TAPE 
control (Direct Out Level in the ASSIGN win-
dow).

CUE 1 CUE 2

MIC LINE

POT CONTROLS

PAN
L/R

PAN
F/B

7 8

5 6

3 4

1 2

TRIM

PAN PAN

9-10 11-12

LEVEL
TO

TAPE

❏ If you want to monitor from the multitrack, 
remove Bank 1-24 from the L/R mix. This has 
no effect on the output to tape.

ASSIGN BUTTON
SETUP

REC

READ

WRITE

L - RASSIGN

To remove channels from the L/R mix: Select L-R and turn off the 
channel ASSIGN buttons.

ASSIGNASSIGNASSIGN ASSIGNASSIGNASSIGNASSIGN

❏ Adjust control room monitor mix from Bank 
25-48 using the channel faders. Verify channel 
assignment to the L/R bus.

GROUPS

49-72

MIDI

MSTRS

1-24 25-48

❏ Set levels in headphone system for musicians.
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phone sends. It’s often convenient for the musicians 
to, at fi rst, monitor the L/R mix in the cue section 
(CUE 1 and 2). Once the initial L/R mix is estab-
lished, copy it to the appropriate cue (PHONES 
SETUP > Copy Mix to Cue), then customize for 
individual monitoring needs.

❏ Adjust headphone monitor volume in the 
PHONES section.

PHONES 2PHONES 1

1 2

SETUP C/R

1 2

SETUP C/R

❏ Route individual channels to the internal effects 
in the ASSIGN window.

❏ Adjust the channel aux levels to route channels 
to outboard effects.

❏ Verify that the MIX OUT is connected to the 
mixdown machine.

A

B

MIX OUT CARD

SPDIF

SPEAKERS

PHONES

MIX OUT

IN

OUT

IN

L R

1 2

L R

L R

OUT

AES/EBUCassette or DAT Recorder

The mix should be arriving at the mixdown re-
corder. It’s good to check this as part of your track-
ing process. At the conclusion of a session the artist 
will probably want to take a  rough mix for evalua-
tion—you’ll look better if it’s already set to go.

❏ Record a pass on the multitrack

Play multitrack back—playback should sound 
identical to tracking and you’re ready to print a 
rough mix.
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This diagram shows a typical hookup for tracking 
and mixdown. With the signal routing fl exibility of 
the Digital X Bus, you don't need to change your 
connections when moving from the tracking to the 
mixdown stage.

Tracking
Microphones and instruments are connected to 

the Mic and Line inputs on three Mic/Line 4 cards 
installed in the A•SLOTS on the Digital X Bus. If 
any of the microphones require phantom power, it 
can be turned on for the applicable channels in the 
Card Setup window (Windows > I/O Confi guration).

Note: During tracking, dynamics control, like com-
pression and limiting, are often used on individual 
channels. Effects, like reverb, delay, and chorus 
are best left for adjustment during mixdown, or 
during tracking for monitor use only.

Each input channel 1-24 is assigned to a tape out-
put via three DIGI cards installed in the B•SLOTS 
on the Digital X Bus using the Bank to Outputs 
command (Options > Bank to Outputs > Outputs 
25-48), or individually using the Direct Outputs (in 
the ASSIGNS window). The OPTICAL OUTs on the 
DIGI cards are connected to the Optical Inputs on 
the digital multitrack recorder. 

 Monitoring
Connect the outputs from the recorders to the Op-

tical Inputs on the Digital X Bus. Assign the Optical 
Inputs to channels 25-48 (Options > Route to Bank 
> Inputs 25-48). This allows you to monitor the sig-
nal as it’s being recorded (assuming your recorder 
has that capability). 

To do this:

•  Assign channels 25–48 to the L-R bus.

• Roll tape to verify signal at Bank 25-48.

• If any track reads excessively hot or cold on the 
Digital X Bus meter bridge, adjust the Digital 
Trim (in the ASSIGNS window) for a reading 
around –15 with no clipping indications on the 
peaks.

• With channel faders off, set the Master Fader at 
unity (U).

•  The signal at the SPEAKERS A and SPEAK-
ERS B output is determined by the Control 
Room Source selection in the Control Room 
Section. SPEAKER A is used for the Control 
Room Monitors.

• Assign L-R as the Control Room Source. Adjust 
the speaker level to a moderately conservative 
level (about 9:00).

• You can connect a pair of headphones to the 
PHONES 1 or 2 jack and monitor the signal 
there as well. Select CONTROL ROOM as the 
source in the PHONES 1 or 2 Section.

• Adjust the channel faders for an appropriate 
monitor mix.

Mixdown
Mixdown setup is very similar to the monitoring 

setup. The main difference is that you are mixing 
the signals that have already been recorded rather 
than monitoring the signals as they are being re-
corded. During mixdown, you can use internal and 
external effects, and automate your mix. There is 
more about automation to come.

The confi guration shown has four external digital 
effects devices connected to an AES card for moni-
toring and mixdown. Typically you would use the 
aux sends to route signals to external effects. Open 
the AES Card Setup window (Windows > I/O Con-
fi guration > AES Card) and assign the appropriate 
aux sends in the Output Source drop-down boxes.

You can also route individual channels to the 
internal effects in the ASSIGN window via the chan-
nels inserts. Effects devices must already be cre-
ated in the Effects Rack for them to appear in the 
insert drop-down boxes.

❏ The Left and Right MIX OUT jacks are con-
nected to the 2-Track recorder for the fi nal 
mixdown.

❏ If you prefer to monitor from the output of the 
mixdown recorder, simply connect the outputs 
of the mixdown recorder to a pair of unused in-
puts (or the AES/EBU or S/PDIF digital inputs 
on the MIX OUT card), and choose those inputs 
for the Control Room Source.

❏ Record the mix and enjoy the mind-boggling 
capabilities of the Mackie Digital X Bus.
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 Before we look at more setup examples, lets cover 
some quick tips on effi cient use of the Digital X Bus 
plug-ins. Follow these easy steps to use the Digital 
X Bus internal plug-ins.

The Digital X Bus comes with a Stereo Delay and 
a Reverb. Additional plug-ins can be purchased and 
installed on the Digital X Bus using the Package 
Installer (File > Install Packages). Visit our website 
at www.mackie.com to learn more about available 
plug-ins.

Note: Other 3rd-party plug-ins not tested and 
packaged by Mackie can be installed using the 
“Launch 3rd Party Installer” command under the 
File menu. This runs any executable (.exe) fi le at-
tached to a USB port (CD or Flash drives) or from 
the internal hard drive.

1. Open the Effects Rack (Windows > Effects 
Rack).

2. Click the New Plugin button in the upper left 
corner and select an effect from the list of avail-
able plug-ins in the NEW PLUGIN window, then 
click OK.

3. You can select the same plug-in multiple times. 
They appear as consecutively numbered effects 
in the effect rack (e.g., Reverb 1, Reverb 2, etc.).

Note: Each effect has a drop-down box to select 
the input source for the effect. You can select an 
Aux Send (1-12), or a channel or master pre- or 
post-insert point. 
•  If you select an Aux Send as the source for the 
effect, you must return the signal to the mix by 
selecting the output from the effect as the input 
source on an unused channel. 

     
•  If you select a channel or master insert as the 
source for the effect, the output of the effect is au-
tomatically returned to the channel's insert point.

You can save the settings for an effect as a preset. 
Click the MENU button in the upper-right corner of 
the effect and select Presets to open the PRESETS 
window. Click New to save the settings under the 
NEW PRESET name of your choice. Click Load to 
copy a preset's settings to the effect.
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To use an internal effect on an Aux Send:

1. Adjust the Aux Send level on the individual 
channel(s) you want to send to the internal ef-
fect (Windows > Auxes). Use Cue 1 (Aux 9/10) 
or Cue 2 (Aux 11/12) if you want to use a stereo 
effect.

2. Open the Effects Rack (Windows > Effects 
Rack) and, if you haven't done so yet, load the 
effect into the Effects Rack using the New Plug-
in button.

3. Select the Aux Send as the input source for the 
effect. If using the stereo feature of an effect, 
select Aux 9/Aux 10 (or Aux 11/Aux 12) as the 
left and right input sources, respectively.

4. On an unused channel, select the output of the 
effect as its source. If using the stereo feature 
of an effect, assign the effect's left output to 
one channel and the right output to an adjacent 
channel. Use the PAN control to pan the effects 
return left and right.

5. Use the instrument or vocal channel's Aux Send 
(touch the Auxes section of the channel strip to 
open the AUXES window, or click and drag on 
the horizontal bar in the Auxes section) to ad-
just the amount of signal going to the selected 
effect.

6. Use the Aux Master (Fader Bank 4: MASTERS) 
to adjust the overall level going to the selected 
effect.

Note: The default setting for each Aux Master level is 
0.0 dB (unity gain). This typically provides suffi cient 
send level and doesn’t usually require adjustment.

7. Use the channel fader for the effect return(s) 
to control the amount of processed signal 
returning to the left and right bus (make sure 
L-R is selected in the Assign section for the 
channel(s).

To use an internal effect on a channel or master insert:

1. Open the Assign Window (Windows > Assign) 
and select the effect in the Pre Insert or Post 
Insert drop-down box.

Note: The effect must be loaded in the Effects 
Rack before it appears in the drop-down box.

2. The signal is automatically routed to the ef-
fect's input and returned to the selected insert 
point in the channel's signal path.

Note: See the instruction manuals for your plug-
ins for specifi cs on individual functionality.

Dynamics and EQ Applications

Dynamics and equalization are typically applied in 
one of two ways:

1.  Processing Dynamics and EQ Before Tape

• Touch the Equalizer box on a channel that is 
being routed to tape (Fader Bank 1) in the chan-
nel strip to open the EQUALIZER window (or 
select Windows > Equalizer).

• Adjust the EQ to taste.

• Double-click the SELECT button on the channel 
to open the on-screen Dynamics window (Com-
pressor and Gate).

• Set compression or gating.

2.  Processing Dynamics and EQ After Tape

• Touch the Equalizer box on a channel that is re-
turning signal from the multitrack recorder for 
mixdown (Fader Bank 2) to open the EQUAL-
IZER window (or select Windows > Equalizer).

• Adjust the EQ to taste.

• Double-click the SELECT button on the channel 
to open the on-screen Dynamics window (Com-
pressor and Gate).

• Set compression or gating.

Since a tape return receives its feed from the mul-
titrack, dynamics and EQ changes made here don’t 
affect what is printed to tape.

Other applications include applying dynamics and 
EQ to an external effects send via a master Aux 
Send channel (Fader Bank 4: MASTERS), or apply-
ing dynamics and EQ to an external effects return 
(returned via an unused channel).

In addition, the eight master buses (Bus 1-8) and 
the Mix Left and Right buses have dynamics and EQ 
controls as well.

Dynamic and EQ control should occur only once 
in any given signal path. Avoid subjecting any signal 
path to multiple stages of dynamics or EQ processing. 
As a rule, fewer circuits almost always result in more 
pristine and accurate audio—even though the X.200 
signal path is incredibly accurate and transparent. 

Many engineers prefer to save all EQ for mix-
down, so as to include the least audio manipula-
tion for a more pure sound. Many recordists rough 
the sound in when recording, using whatever EQ 
and dynamics they feel the sound needs, then they 
perfect the audio during mixdown. Many excellent 
recordings have been the result of these techniques 
and more. Experiment, and let your ears determine 
what works best for you. 
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 MIDI Basics
Your Digital X Bus works very well when incorpo-

rated in a MIDI network, using a computer refer-
enced to  time code. 

Be sure to connect the X.200 MIDI jacks to your 
MIDI interface. Within your computer-based MIDI 
sequencer, set the MIDI channel connected to the 
X.200 to transmit MIDI Time Code ( MTC). This is 
necessary to run automation from a Digital Audio 
Workstation (DAW).

MIDI Interface

MIDI
IN

X.200
MIDI
OUT

You can use the X.200 MIDI ports with a USB 
MIDI interface.

USB MIDI Interface

MIDI
IN

X.200

USB

MIDI
OUT

You can also use the USB port on the X.200 with 
a USB MIDI interface. However, because the X.200 
USB port and a computer's USB port are both con-
fi gured as hosts, which are designed to connect to 
a USB port confi gured as a device (like a USB MIDI 
interface), you must use two USB MIDI interfaces 
connected as shown below. This confi guration al-
lows you to use many more MIDI channels than the 
16 provided by a standard MIDI port, up to 64 chan-
nels when using two 4x4 USB MIDI interfaces.

USB MIDI Interface

USB MIDI Interface

X.200
USB

x64

Host

Device

Device

Standard
MIDI
Ports

Host

x64

16x4 16x4

When you don’t include a computer in your setup, 
you need a device like the Alesis BRC to transmit 
MTC to and from the X.200 for time reference when 
performing automation. 

Modular Digital  Multitrack

Modular Digital  Multitrack

BRC

Digital X Bus

MIDI SYNC

SYNC
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The Digital X Bus provides control over some key 
MIDI parameters. These parameters affect your 
system’s ease of use and effi ciency, and should be 
verifi ed in the Setup Mix Options and Setup MIDI 
windows:

•  MMC  DEVICE ID: Some 8-track digital re-
corders require that you defi ne the device ID 
numbers used for each recorder in the MIDI 
Machine Controller. Typically, tracks 1–8 are 
device 0, tracks 9–16 are device 1, and tracks 
17–24 are device 2, so these are the default set-
tings.

•  ONE BUTTON PUNCH: You can also select 
whether to press the PLAY and RECORD but-
tons to enter record mode, or just press the 
RECORD button (One Button Record). 

Note: We recommend leaving One Button Record 
off to provide an extra measure of safety in case 
you inadvertently press the RECORD button in the 
Transport Section.

•  SONG OFFSET: Song Offset can be used to in-
dicate the starting time deviation of a  Standard 
MIDI File (SMF), referenced to absolute time 
code.

•  TEMPO MAP: If you use a  sequencer in your 
recording process, you can create a standard 
MIDI fi le from the song(s) you’ve recorded. 
Copy the tempo map from the SMF to the Digi-
tal X Bus and “synchronize” the X.200 display 
to the Bars:Beats:Ticks of the sequenced pro-
gram. SMFs are loaded from a USB Flash drive.

  Word Clock and the Digital X Bus —
The Kitchen Sync

In order for all digital components to function 
together in unity, they must all move together, 
sample-by-sample, through the digital data stream. 

Word clock is an incredibly important part of 
digital recording! The concept is simple: If multiple 
devices are synchronized together via word clock, 
they progress together through the digital data 
stream, one sample at a time. This is called sample-
accurate sync. 

Each system works in reference to one master 
device. Forty-eight thousand times a second (or 
whatever the common sample rate is) digital slaves 
keep track of the word clock status of the master 
device; they only output the next sample when the 
master device outputs the next sample.

This type of system provides very accurate 
synchronization. Incorporating a time reference, 

like MTC, along with sample accurate sync enables 
time stamping of data changes, like start-stop time, 
snapshot placements, real-time automation data, 
etc. Hence, ultimately fl exible and way cool automa-
tion capabilities of virtually every control on the 
Digital X Bus! Yahoo!

The Sync card in your Digital X Bus provides a 
means to send and receive digital word clock. 

This card is used:

• When digitally combining the Digital X Bus with 
a computer-based DAW, MDMs, video recorders, 
etc.

• When the Digital X Bus must send or receive 
word clock other than through  ADAT lightpipe 
or  AES/EBU connections.

Sync data can transmit directly through ADAT 
Lightpipe and AES/EBU connections. However, a 
complete sync system needs two main ingredients: 

• Word clock, sample-accurate sync. This is 
provided through the Digital X Bus optical or 
AES/EBU connections, and through the Sync 
card.

• Time reference to stamp automation data for 
accurate playback. This is typically provided 
through MIDI  Time Code ( MTC).

 Proper  Sync Connection
Every digital system needs a master sync source. 

The X.200 prefers to be the master source but will 
function as a master or slave. Follow these simple 
steps to help assure a successful digital setup:

• Determine which piece of gear is the master. 
The master must be able to generate proper 
 word clock that can be read by all other digital 
equipment.

• Set all digital equipment to the exact same 
word clock rate—the X.200 can operate up to 
192 kHz.

• Connect the word clock output from the mas-
ter device to the word clock input of the slave 
devices. Each digital device connected to the 
digital audio chain must receive a common word 
clock source, either directly or from a slave.

• It is common procedure to chain word clock 
through digital devices. The X.200 can provide 
master word clock to a central word clock hub, 
then the hub can send to multiple digital slaves 
(DAWs, MDMs, digital effects, etc.). 

• Set every slave device to respond to external 
word clock.
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system. This will help you verify a logical 
connection scheme. One piece of equipment 
connected incorrectly can mess up your entire 
system. Rats!

The following illustration shows a common sync 
setup, using the Digital X Bus as the master word 
clock source and a hub to distribute to other digi-
tally connected devices.

Modular Digital  Multitrack

Modular Digital  Multitrack

Sync Hub

Digital X Bus
Master Word Clock 

Out From Digital X Bus

Here are two more sample setups that include 
the Digital X Bus and other digital devices which 
depend on accurate and solid word sync.

Use expensive, properly impedance-matched 
cabling! It’s worth it!

Verifying  Word Clock Sync Between Devices 
and the Digital X Bus
• When the Digital X Bus is set to “Internal” in 

the Clock Card Setup window, it generates word 
clock as a master device. All other devices must 
be connected as slaves.

Tip: A quick way to open the Clock Card Setup 
window is to touch the sample rate display in the 
upper-right part of the screen, next to the L/R 
meters.

• If the Digital X Bus is slaved properly to a mas-
ter word clock source, the sample rate indicator 
in the top menu bar (right screen) lights con-
tinuously.

• If the Digital X Bus is improperly connected as 
a slave to the digital network, or not receiving a 
valid Word Clock at the WORD CLOCK IN con-
nector, the sample rate indicator blinks.

9-pin 
OUT

MIDI 
IN

MIDI 
OUT

MIDI 
IN

MIDI 
OUT

DTP

Word 
Clock 
INPUT

Word 
Clock 
INPUT

Word 
Clock 

OUTPUT

MTP
AV

Word 
Clock 

OUTPUT

9-pin  
IN

Control 
Track IN

Control 
Track 1

9-pin 
OUT

PCI-324
9-pin IN

C
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er

MIDI 
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MIDI 
OUT

PCI 324 card 
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From PCI 

M
ID
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IN

M
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MTP
AV
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You probably have a bad word clock sync connec-
tion if:

• You hear audio but it cuts in and out at regular 
intervals.

• There is no audio signal at the input of the 
Digital X Bus even though everything seems to 
be connected properly.

• All meters are full on and you hear a very ugly 
grating, grinding, static sound.

• When the record/playback device transport 
is engaged, you see the sample rate indicator 
fl ashing at the top of the right screen.

Troubleshooting Word Clock Problems
• Troubleshoot through the system from the mas-

ter through the slaves. Connect the fi rst two de-
vices and verify their functionality. Once they’re 
up and running, add the next device, and so on. 
This is the most effi cient manner to check out a 
system.

• Verify connection, integrity, and quality of all 
sync cables.

• Verify a consistent sample rate setting on all 
connected sync devices (all set to the same 
sample rate—44.1, 48k, etc.)

• Verify that the master sync source word clock 
output is connected to the word clock input 
of the slave, and that additional slaves also 
receive word clock. Slaves can either receive 
word clock directly from the master device or 
daisy-chained through connected slaves. Patch 
word clock out of a connected slave into the 
word clock input of any other slave.

• Verify that the master device word clock status 
is set to INTERNAL.

• Verify that all slave devices are set to follow 
EXTERNAL word clock.

• If the system doesn’t seem to work correctly, 
you might have an intermittent or broken sync 
cable. Always use high-quality 75Ω BNC word 
clock cables. 
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When connecting the Digital X Bus to a Digital 
Audio Workstation ( Digital Performer,  Studio Vision 
Pro,  Cakewalk Pro, etc.), word clock synchroniza-
tion must be addressed; the master and slaves must 
be established; the clock rate must be consistent 
throughout; and the audio path into the console 
must be intelligently confi gured.

Let’s consider a common computer-based setup 
using: 

• A combination digital audio/MIDI software 
package

• A MIDI interface (or in this example, two 4x4 
USB MIDI interfaces)

• A digital audio interface with lightpipe audio 
connections

Cabling and Hookup
(Refer to illustration on the next page.)

1. Connect the Digital X Bus lightpipe output, 
from the DIGITAL card, to the digital audio 
interface lightpipe input. Likewise, connect the 
lightpipe output from the digital audio interface 
to the Digital X Bus' lightpipe input.

2. Connect the digital audio interface to the com-
puter per the manufacturer’s specifi cations.

3. Connect the SMPTE I/O from the Digital X Bus 
Sync card to the SMPTE I/O on the digital audio 
interface to provide time code communication.

4. Connect the two 4x4 USB MIDI interfaces 
together via their MIDI IN and OUT connectors, 
and connect one to the USB port on the Digital 
X Bus and the other to the USB port on the 
digital audio interface.

Settings
Digital X Bus

1. Open the I/O Confi guration window.

2. Click the Digital Card to open the TDIF-ADAT 
Setup window.

3. Click the ADAT Inputs box at the bottom of the 
TDIF-ADAT Setup window.

4. The inputs and outputs for the Digital card are 
confi gured for their default settings based on 
the card's position in the card cage. You can 
change the output settings in the TDIF-ADAT 
Setup window, and the input settings in the 
input Assign window.

5. Open the I/O Confi guration window and click 
the Sync card to open the Clock Setup window.

6. Set the Digital X Bus Sample Rate to match 
the computer’s sample rate (typically 48kHz or 
44.1kHz). Selecting “Internal” in the Sample 
Clock drop-down box establishes the Digital X 
Bus as the master. Everything else in the digital 
chain must be capable of slaving to the Digital 
X Bus.

 DAW 

1. Set the digital audio interface to follow  ADAT 
optical at the interface input (from the Digital X 
Bus lightpipe output).
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The Digital X Bus is an amazing tool, no matter 
what the setup. However, the more complex the 
setup, the more amazing the Digital X Bus becomes. 
Post-production provides the potential to use any 
tracks, effects, snapshots, automation moves, and 
general madness mayhem. 

Most post-production facilities use house sync to 
lock all video equipment together. The same piece 
of gear that generates house sync can provide the 
Digital X Bus and all connected audio gear with the 
necessary word clock to get everything functioning 
properly together.

In order for the Digital X Bus to follow external 
word clock, the Sample Clock setting for the Sync 
card must be set to “Word Clock.”

This is also the type of setup that might be found 
in a home studio that incorporates a central sync 
generator.

 Bouncing/Summing Using Bus Outs

You may fi nd that you need to free up some more 
tracks to get everything to fi t. You can do a submix 
and combine several tracks into one (or two) using 
the BUS 1–8 Submasters.

Maybe you have six separate tracks for the kick 
drum, snare drum, cymbals left, cymbals right, tom 
1, and tom 2. You can free up fi ve extra tracks by 
bouncing these down to one track, or free up four 
extra tracks if you want to bounce them down to a 
stereo pair of tracks.

The following steps show an example of how to 
bounce tracks 1–6 down to tracks 7 and 8 by using 
Bus 1 and 2. By using Buses 1 and 2, whatever pan 
positioning you’ve set up is retained.

1. Turn off the L-R assignments for the six chan-
nels serving as the tracks 1–6 returns. Turn off 
the L-R assignments for any other channels you 
don’t want to monitor while bouncing down.

2. Assign the six channels to Bus 1 and Bus 2.

3. Open the I/O Confi guration Window, and select 
Bus 1 and Bus 2 as the Output Source for two 
unused outputs on an I/O card. Route the two 
outputs to tracks 7 and 8 inputs on the record-
ing device.

4. Press the MSTRS button next to the Master 
Fader to select Fader Bank 4. The Bus Masters 
default to unity gain, but you can adjust the Bus 
1 and 2 Masters to optimize the signal going to 
the recording device.

5. On the recording device, select record ready on 
tracks 7 and 8.

6. Play the song while recording tracks onto the 
multitrack.

7. After recording, with the original 6 channels 
muted, monitor the bounced tracks (7 and 8) 
through the Digital X Bus tape in channels.
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Using Basic Automation

What Type of Data Can Be Automated
Virtually all of the Digital X Bus channel param-

eters are available for automation. However, there 
are a few exceptions—some obvious and some not 
so obvious. All Digital X Bus channel parameters 
can be automated except:

• Input Source selection

• Direct Output selection

• Floating, Pre, and Post Insert selections

• Digital Trim

• Phase Reverse

• Direct Out Level

Two Types of Automation
Automation moves are divided into two basic 

types: snapshot and dynamic. Snapshot automation 
makes it possible to instantly reset all automated 
console settings to a predetermined fi xed (static) 
position with a single command (snapshot recall). 
Dynamic automation allows you to record and play 
back any parameter changes, like fader positions 
or mute toggles, in real time while locked into time 
code.

The Digital X Bus is powered by Mackie’s Real 
Time OS™ automation software. Upon initial power-
up, the console Automation Section is bypassed. 

Snapshot Automation

Snapshot automation refers to simply scrolling 
through various snapshots at the appropriate time 
and place. (Recalling snapshots in the proper order 
and position can be accomplished through connec-
tion to a MIDI sequencer, or by placing snapshot 
events in the Event Automation Track.)

Your MIDI sequencer sees a snapshot selection 
as a simple patch change, which can be recorded as 
part of the same sequence that might contain all or 
a portion of your music. 

• Set the sequencer to receive and record MIDI 
patch change data from the D8B MIDI channel 
and cable.

• Select “MIDI Snapshots” in the Setup>Mix  Op-
tions window.

• Run the sequence with the D8B receiving MTC 
from the sequencer.

• Place the sequencer in record mode on the 
D8B channel as you scroll through snapshots. 
Each of these snapshot changes record into the 
sequence.

• Play the sequence back with the D8B receiving 
MIDI playback at its MIDI input.

• Snapshots will playback in the same time and 
order that you selected them.

• To fi ne-tune snapshot placement, open the se-
quence track and adjust the time position in the 
MIDI sequence.

Dynamic Automation

Dynamic automation is a function of the Digital X 
Bus automation system. The power and fl exibility 
offered by the Digital X Bus is awesome. This one 
tool can revolutionize the way you do music. 

Each new automation pass helps mold and shape 
the music into a brilliant work of art. Dynamic au-
tomation involves real-time crafting of the mix with 
the assistance of a computer processor. 

Where Do I Start?

Automation is somewhat intimidating at fi rst. For-
tunately, it doesn’t need to be. The power, fl exibility, 
and ease of use provided by the Mackie designers 
makes the Digital X Bus painless and intuitive. 

If you’ve used other automation systems, you 
have a defi nite advantage. The concepts involved, as 
they apply to the Digital X Bus, are similar to most 
automation systems. The advantage the Digital X 
Bus offers over most other automation systems is 
its mind-boggling ability to automate virtually every 
parameter on the console. 

The following is a step-by-step, streamlined 
procedure to help get you automating. To clarify ter-
minology and basic layout, refer to the Automation 
Window description (page xx) in this manual.

Automation In Bypass

• Begin by setting up a basic mix with automation 
off. Select BYPASS in the Automation section of 
the control surface or in the Automation win-
dow (Windows > Automation).

Clear Automation

To avoid errant data, select all channels and clear 
all types of automation data. 

• Under the Channels menu, choose “Select All 
Faders (Alt+Shift+A).”

• Choose Clear Automation… from the Edit Menu. 
Make sure the Mix Editor window is closed.

• Check “Entire Channel” from the CLEAR AUTO-
MATION window, then click OK.
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• Name your mixes in a manner that is easy to 
reference consecutive revisions: For example, 
“BigBadBob Mix 1,” or “BigBadBob rev 1.0.”

• Using “rev 1.x,” “rev 2.x,” etc. provides an easy 
way to indicate major conceptual changes (1.0, 
2.0, 3.0, etc.) from minor refi nements (1.0, 1.1, 
1.2, etc.)

Setup Rough Mix

• Build the basic sound of the mix. Include funda-
mental EQ, Pan, Surround, Dynamics, Groups, 
etc.

• Save frequently, or set the Digital X Bus for 
Smart Saves (Windows > Setup > General) at 
regular intervals.

Save Snapshot For Safety

As you build the mix, save snapshots as soon as 
the music begins to reveal itself. Label the snap-
shots for your own reference. Sometimes these ba-
sic mixes, which are derived from your initial “gut” 
reaction to the music, are the most powerful. 

Basic dynamic automation does not require these 
snapshot saves, but they’re often useful as the mix 
comes together, even if only as a cross-reference. If 
you develop a string of snapshots that are very pow-
erful, they can be strung together during automa-
tion. However, the procedure we’re outlining here 
highlights dynamic automation.

Time Code From Playback Device
Route MTC

The Digital X Bus requires MIDI Time Code 
(MTC) at the MIDI input to operate automation 
along with the record/playback device.

• Connect the MIDI output of your computer, 
sequencers, MIDI interface, or transport control 
to the MIDI input of the Digital X Bus.

• Most sequencers or other record/playback 
devices that transmit MTC need to be confi g-
ured to route to a specifi c MIDI channel, cable, 
or device. Consult your MTC source operator’s 
manual to confi rm accurate and verifi able rout-
ing to the Digital X Bus.

Verify MTC at Digital X Bus Locator Position 
Display

• When your sequencer or other record/playback 
device is running and MTC is transmitted, the 
Digital X Bus control surface position readout 
window (upper-right corner of screen) will 
scroll MTC. You will see a continuous increase 

of Hours, Minutes, Seconds, and Frames. If you 
see this scrolling time code in the time code 
display, it’s almost automation time!

• MTC also displays in the Locator window.

Start Automation
Once your ducks are in a row, you’re ready to 

begin the automation process! Automation can be 
written from the beginning of time code (00:00:00:
00) to the end (23:59:59:30).

Save Default Levels

Saving the Digital X Bus settings to a default 
state determines the starting point for the entire 
mix. You may have already created one or more 
default states and saved them as templates.

• Determine that your mix is solid enough that 
you’d like to have all parameters written as 
defaults. Don’t get too freaked out about this—
you’ll be tweaking the mix to perfection anyway.

• Select “Save As Template...” from the File Menu.

• Enter a name for your new template and click 
OK.

• If you need to recall your static mix at any point, 
you can save or update snapshots at any time.

Exit Bypass Mode

Once the default levels have been set, it’s time to 
exit BYPASS mode (turn the BYPASS button off). 
From this point on, any parameter change can be 
written into automation.

Select Parameters

Choose the parameters you’d like to record as 
automation data on the fi rst pass. This is typically a 
great time to ride basic fader, mute, and pan set-
tings. However, there is no problem with selecting 
Faders, Mutes, Pan, and ALL so no matter what 
moves you make, they can be recorded and recalled 
by the automation processor.

Any Combination of Faders, Mutes, and Pans on 
First Pass

• Choose automation parameters by selecting 
them in the control surface AUTOMATION sec-
tion or in the Automation window (Windows > 
Automation). 

• Assign the channels you want to automate by 
pressing the WRITE button in the ASSIGN 
BUTTON SETUP section on the control surface, 
and pressing the ASSIGN button on the chan-
nels you want to automate.



75Owner's Manual

O
w

n
e

r's M
a
n

u
a
l

Note: Faders, Mutes, and Pan all apply individu-
ally to the one parameter they name. ALL applies 
to all automation parameters other than Fad-
ers, Mutes, and Pan. Open the Automation Filter 
window from the Automation window to select the 
individual parameters included under the ALL (or 
Other) selection.

Safety Net: You can undo any automation pass or 
series of passes using the History List. You can 
also redo your undo. Or undo your redo. Or undo 
your hairdo.

Start playback device

• Verify MTC in the Locator position display.

• Verify selection of desired automation param-
eters—for now select FADERS, MUTES, PAN, 
and ALL.

• Verify selection of desired channels by mak-
ing sure their ASSIGN buttons are lit when the 
WRITE button is lit. This is also indicated in 
the channel strip on the Touchscreen just below 
the EQ window, by an illuminated “W” button.

Move a channel fader

• As soon as the fader moves on a write-enable 
channel, automation data is recorded.

• Open the Mix Editor (Windows > Mix Editor) to 
verify that automation data has been recorded.

Exit Record and Rewind to Beginning of Track

• Stop playback or turn off the ASSIGN button on 
the active channels to exit automation record 
mode. Rewind playback/record device to the 
beginning of the automation pass.

Start Playback from Beginning of Track

• If you’ve followed these directions thoroughly 
you’ll see the fader move that you recorded 
playback automatically.

• Welcome to the wonderful world of Digital X 
Bus automation!

Repeat this Action for More Parameters

• Be sure you’ve selected the desired parameter 
before attempting the automation pass.

• Each time you perform a new automation pass, 
new data combines with the old in a seamless 
manner. Continue building the mix until every-
thing is just right.

Trim Levels
This mode is perfect for updating sections of 

a mix. If you’ve worked and toiled over a track 
throughout a mix, adjusting the levels frequently, 
try TRIM mode. This valuable mode simply adds 
or subtracts from a previously adjusted automation 
track. This mode only applies to faders. All previ-
ous moves are maintained but the overall volume 
changes. 

• Press TRIM in the control surface Automation 
section or in the Windows > Automation win-
dow. If you select “Trim From Unity,” the faders 
all snap to unity position.

• Use the channel faders to boost or cut previ-
ously automated channel data.

• When “Trim From Unity” is selected, the faders 
automatically set at unity so they can be easily 
used to boost or cut the previously adjusted 
track content. 

• This is an excellent mode to globally adjust 
channel levels.

• Simply raise or lower the fader level to boost or 
cut the sum of your previous adjustments for 
the selected channel.

Automate EQ, Dynamics, and Effects
Automation of EQ, dynamics, and effects is 

simple. 

• Select automation mode (ALL).

• Open the Automation window and click the 
Filter button to open the Automation Filter 
window.

• Make sure EQs, Dynamics, and Misc are 
checked.

• Start the playback/record device.

• Make changes.

In order for these parameters to record, ALL must 
be selected in the control surface AUTOMATION 
section or OTHER in the Automation window.

Editing Automation
Once automation has been recorded on the Digital 

X Bus, it can be edited in the Mix Editor. Refer to 
the description of the Mix Editor on page xx for 
information on using the Mix Editor tools to edit 
automation data.
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Bad Output

• Is the associated level control (if any) turned 
up?

• Is the output source correctly assigned in the 
Card Setup window?

• If it’s a stereo pair, try switching them around. 
For example, if a left output is presumed dead, 
switch the left and right cords at the mixer end. 
If the problem stays on the left side, it’s not the 
mixer.

Bad Sound

• Is the input connector plugged completely into 
the jack?

• Is it loud and distorted? Make sure the input 
GAIN control for the input is set correctly. 
Reduce the signal level on the input source if 
possible.

• If possible, listen to the signal with head-
phones plugged into the input source device. If 
it sounds bad there, it’s not the Digital X Bus 
causing the problem.

Noise/Hum

• Turn down each channel, one by one. If the 
noise disappears, it’s coming from whatever is 
plugged into that channel.

• Check the signal cables between the input 
sources and the Digital X Bus. Disconnect them 
one by one. When the noise goes away, you’ll 
know which input source is causing the prob-
lem.

• Sometimes it helps to plug all the audio equip-
ment into the same AC circuit so they share a 
common ground.

Warranty Service
Details concerning Warranty Service are spelled out 
in the Warranty section on page xx.

If you think your Digital X Bus has a problem, 
please do everything you can to confi rm it before 
calling for service. Doing so might save you from 
the deprivation of your Digital X Bus and the associ-
ated suffering.

These may sound obvious to you, but here are some 
things you can check. Read on.

Troubleshooting
No Power

• Our favorite question: Is it plugged in?

• Make sure the power cord is securely seated in 
the IEC socket and plugged all the way into the 
AC outlet.

• Make sure the AC outlet is live (check with a 
tester or lamp).

• Is the POWER switch on? Make sure the 
POWER switch on the rear panel is in the ON 
position (up).

Bad Channel

• Is the MUTE button pushed in?

• Is the input GAIN control for the channel turned 
up?

• Is the fader turned up?

• Is the Input Source correctly assigned in the 
ASSIGN window?

• Is the signal source turned up? Make sure the 
signal level from the selected input source is 
high enough to light up some of the INPUT 
meter LEDs next to the channel’s fader.

• Is the channel assigned to a bus or output?

• Try the same source signal in another channel, 
set up exactly like the suspect channel.
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Repair
Service for Mackie products is available at a factory-
authorized service center. Service for Mackie prod-
ucts living outside the United States can be obtained 
through local dealers or distributors.

If your Digital X Bus needs service, follow these 
instructions:

1. Review the preceding troubleshooting sugges-
tions. Please.

2. Call Tech Support at 1-800-898-3211, 7 am to 
5 pm PST, to explain the problem and obtain a 
Service Request Number. Have your Digital X 
Bus’ serial number ready. You must have a Service 
Request Number before you can obtain service.

3. Pack the Digital X Bus in its original pack-
age, including endcaps and box. This is VERY 
IMPORTANT. Mackie is not responsible for any 
damage that occurs due to non-factory packaging.

4. Include a legible note stating your name, ship-
ping address (no P.O. boxes), daytime phone 
number, Service Request Number, and a detailed 
description of the problem, including how we can 
duplicate it.

5. Write the Service Request Number in BIG PRINT 
on top of the box. Units sent without a Service 
Request Number will be refused.

6. Tech Support will tell you where to ship the 
Digital X Bus for repair. We suggest insurance 
for all forms of cartage.

7. We’ll try to fi x the Digital X Bus within three 
to fi ve business days. Ask Tech Support for the 
latest turn-around times when you call for your 
Service Request Number. The mixer must be 
packaged in its original packing box, and must 
have the Service Request Number on the box. 
Once it’s repaired, we’ll ship it back the same 
way in which it was received. This paragraph 
does not necessarily apply to non-warranty 
repair.

 Note: You must have a sales receipt from an Au-
thorized Mackie Dealer to qualify for a warranty 
repair.

Need Help?

You can reach a technical support representative 
Monday through Friday 

from 7 AM to 5 PM PST at:

1-800-898-3211

After hours, visit www.mackie.com and click Support, 
or email us at: techmail@mackie.com
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1/4" TS Phone Plugs and Jacks
“TS” stands for Tip-Sleeve, the two connection 
points available on a mono 1/4" phone jack or plug. 
They are used for unbalanced signals.

SLEEVE

TIP

TIPSLEEVE

TIP

SLEEVE

1/4" TS Unbalanced Wiring:
Sleeve = Shield
Tip = Hot (+)

RCA Plugs and Jacks
RCA-type plugs (also known as phono plugs) and 
jacks are often used in home stereo and video 
equipment and in many other applications. They are 
unbalanced and electrically equivalent to a 1/4" TS 
phone plug.

TIPSLEEVETIPSLEEVE

RCA Unbalanced Wiring:
Sleeve = Shield
Tip = Hot (+)

Unbalancing a Line
In most studio, stage, and sound reinforcement 
situations, there is a combination of balanced and 
unbalanced inputs and outputs on the various pieces 
of equipment. This usually will not be a problem in 
making connections.

• When connecting a balanced output to an unbal-
anced input, be sure the signal high (hot) con-
nections are wired to each other, and that the 
balanced signal low (cold) goes to the ground 
(earth) connection at the unbalanced input. In 
most cases, the balanced ground (earth) will 
also be connected to the ground (earth) at the 
unbalanced input. If there are ground-loop prob-
lems, this connection may be left disconnected 
at the balanced end.

• When connecting an unbalanced output to a 
balanced input, be sure that the signal high 
(hot) connections are wired to each other. The 
unbalanced ground (earth) connection should be 

XLR Connectors
Mic/Line 4 cards use 3-pin female XLR connec-
tors on the MIC inputs. They are wired as follows, 
according to standards specifi ed by the AES (Audio 
Engineering Society).

2

2

3 1

1

SHIELD

COLD

HOT

SHIELD

COLD

HOT

3

SHIELD

COLD
HOT

3

2

1

XLR Balanced Wiring:
Pin 1 = Shield
Pin 2 = Hot (+)
Pin 3 = Cold (–)

1/4" TRS Phone Plugs and Jacks
“TRS” stands for Tip-Ring-Sleeve, the three connec-
tion points available on a stereo 1/4" or balanced 
phone jack or plug. TRS jacks and plugs are used 
for balanced signals and stereo headphones:

Balanced Mono

SLEEVE

TIPSLEEVE

TIP

RING

RING

TIP

SLEEVERING

1/4" TRS Balanced Mono Wiring:
Sleeve = Shield
Tip = Hot (+)
Ring = Cold (–)

Stereo Headphones

SLEEVE

TIPSLEEVE

TIP

RING

RING

TIP

SLEEVERING

1/4" TRS Stereo Unbalanced Wiring:
Sleeve = Shield
Tip = Left
Ring = Right
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wired to the low (cold) and the ground (earth) 
connections of the balanced input. If there are 
ground-loop problems, try disconnecting the 
unbalanced ground (earth) connection from 
the balanced input ground (earth) connection, 
leaving the unbalanced ground connected to the 
balanced input low (cold) connection only.

In some cases, you may have to make up spe-
cial adapters to interconnect your equipment. For 
example, you may need a balanced XLR female 
connected to an unbalanced 1/4" TS phone plug. 
Many common adapters can be found at your local 
electronics supply store.

The balanced-to-unbalanced connection has been an-
ticipated in the wiring of Mackie jacks. A 1/4" TS plug 
inserted into a 1/4" TRS balanced input, for example, 
will automatically unbalance the input and make all 
the right connections. Conversely, a 1/4" TRS plug in-
serted into a 1/4" unbalanced input will automatically 
tie the ring (low or cold) to ground (earth).

DB25 Connectors
Not all DB25 connectors are alike. Some provide 

analog audio signals and some provide digital audio 
signals. In addition, there are a variety of digital 
formats that use the DB25 interface, which are 
not compatible with each other. So when you are 
connecting the Digital X Bus I/O cards to other 
equipment, make sure you know what fl avor DB25 
connectors you have and that they are compatible 
with each other.

Analog

The inputs and outputs on the Mic/Line 8 card 
and the Line card provide eight balanced line-level 
signals per DB25 connector. These connectors are 
pin-for-pin compatible with the analog (not TDIF) 
DB25 connectors found on TASCAM DTRS record-
ers, which has become an industry standard for many 
professional audio manufacturers. They are also the 
same pinout as the analog cards for the Mackie D8B 
and hard disk recorders.
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Several companies make DB25-to-DB25 cables 
specifi cally for audio, with proper shielding to re-
duce crosstalk and noise.

DB25 cables that break out to XLR, 1/4" TRS, or 
TT connectors for connecting to other mixers or au-
dio gear are also readily available. See your Mackie 
dealer for details.

Digital

AES/EBU
The AES card has a DB25 connector that pro-

vides digital I/O for eight channels in the AES/EBU 
format. This connector is wired as follows:
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Note: A variety of alternate pin-out confi gurations 
have been developed by various manufacturers for 
the AES/EBU DB25 interface. Make sure the device 
you are connecting to has the same pin-out confi gu-
ration as the Digital X Bus AES card. If not, you will 
need to make a conversion cable so the signals arrive 
at the correct pins on the receiving end of the cable.

TDIF
The DIGI card has a DB25 connector that pro-

vides digital I/O for eight channels in the TDIF 
format. This connector is wired as follows:
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Analog DB25 Output

Digital DB25 TDIF Input/Output
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 Specifi cations (preliminary)
(All specifi cations are subject to change without notice. 
All measurements were calculated between 44.1 kHz 
and 96 kHz sampling frequencies. For these preliminary 
specifi cations, no measurements were calculated for 
192 kHz sampling rate.)

Dynamic Range (maximum signal level to noise level)

Dynamic range measurements are identical for all 
Option Cards
22 Hz to 22 kHz @ 48 kHz SR FS
22 Hz to 40 kHz @ 96 kHz SR FS

Analog In to Digital Out
• 111 dB @ 48 kHz
• 110 dB @ 96 kHz

Digital In to Analog Out
• 108 dB @ 48 kHz
• 108 dB @ 96 kHz

Analog In to Analog Out
• 108 dB @ 48 kHz
• 106 dB @ 96 kHz

THD+N

Measured from analog channel input to analog direct output
• <0.02%, 20 Hz to 20 kHz @ +14 dBu (48 kHz SR, 

measurement BW = 10 Hz to 40 kHz)
• <0.02%, 20 Hz to 40 kHz @ +14 dBu (96 kHz SR, 

measurement BW = 10 Hz to 80 kHz)

Crosstalk

• Better than –80 dB @ 1 kHz (adjacent input channels)

Microphone Inputs

Measured @ 20 Hz to 20 kHz bandwidth, maximum input gain
Rs = 150 ohms
Input pad = Off
• Microphone Input Sensitivity: –75 dBu
• E.I.N:   –127 dBu

Latency

Channel processing enabled/disabled does not affect latency 
measurement.
All analog I/O measurements are the same for any analog con-
nection on any Card.
All digital I/O measurements are the same for any digital con-
nection on any Card.

@ 44.1 kHz – 48 kHz SR
• Mic/Line In to Line Out: 

 246 samples (± 2 samples)
• Mic/Line In to Mix Bus Out: 

 256 samples (± 2 samples)
• Digital In to Digital Out: 

 187.5 samples (± 2 samples)
• AES Input with SRC enabled: 

 +139 samples

@ 88.2kHz - 96kHz
• Mic/Line In to Direct Line Out: 

 426 samples (± 2 samples)
• Mic/Line In to Mix Bus Out: 

 434 samples (± 2 samples)
• Any AES Input to any AES Output: 

 508 samples (± 2 samples)
• AES Input with SRC engaged: 

 +139 samples

Analog Input Sensitivity

All input sensitivity measurements are within ±0.2 dB

LINE CARD INPUT
1 kHz tone with 150 ohm source
• With a +4dBu input reference:

 0 dBFS = +24.3 dBu
• With a –10 dBV input reference:

 0 dBFS = +11.0 dBV

MIC/LINE 4 OR MIC/LINE 8 MIC INPUT
1 kHz tone with 40 ohm source
• At 0 dB input gain with –10 dB pad engaged:

 0 dBFS = +24.9 dBu
• At 0dB input gain without –10 dB pad:

 0 dBFS = +14.8 dBu
• At maximum gain (+65 dB):

 0 dBFS = –50.9 dBu

MIC/LINE 4 LINE INPUT
1 kHz tone with 150 ohm source
• With a +4 dBu input reference:

 0 dBFS = +24.1 dBu
• With a –10 dBV input reference:

 0 dBFS = +10.8 dBV

MIC/LINE 8 LINE INPUT
1 kHz tone with 150 ohm source
• At 0 dB input gain with –10 dB pad engaged:

 0 dBFS = +25.7 dBu
• At 0dB input gain without –10 dB pad:

 0 dBFS = +15.7 dBu
• At maximum gain (+65 dB):

 0 dBFS = –50.0 dBu
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Analog Output Sensitivity

Measured with 1 kHz tone @ 200k ohm impedance

LINE CARD OUTPUT
• 0 dBFS = +24.4 dBu (± 0.2 dB)

MIC/LINE 8 CARD OUTPUT
• 0 dBFS = +24.4 dBu (± 0.2 dB)

MIX OUT CARD OUTPUT
• 0 dBFS = +24.4 dBu (± 0.2 dB)

Frequency Response

Reference signal = 1 kHz @ +4 dBu
• Analog (Line Card) Input to Analog (Line Card) Output
 44.1 kHz:  ± 0.1 dB @ 20 Hz-20 kHz
 48 kHz:   ± 0.05 dB @ 20 Hz-20 kHz
 88.2 kHz:   ± 0.15 dB @ 20 Hz-40 kHz
 96 kHz:   ± 0.1 dB @ 20 Hz-40 kHz

• Digital (AES) Input to Analog (Mix Bus) Output
 44.1 kHz:   ± 0.15 dB @ 20 Hz-20 kHz
 48k Hz:   ± 0.15 dB @ 20 Hz-20 kHz
 88.2 kHz:   ± 0.2 dB @ 20 Hz-40 kHz
 96 kHz:   ± 0.2 dB @ 20 Hz-40 kHz
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Digital X Bus 
X.200 Signal-Flow Diagram
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VST EFFECT(S)
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X.200 Block Diagram
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Digital X Bus Software Installation Procedure

Windows XP Users

USB Flash/Pen Drive Method (recommended)
***Requires a USB Flash/Pen drive***

1.  Download the Software update from www.mackie.com to your local hard drive.

2.  Insert a USB Flash Drive into your computer. Make sure that Windows identifi es the Flash Drive as a 
“USB Mass Storage Device” in the pop-up balloon message from the System Tray.

3.  Right-click on the downloaded fi le and select “Extract All” from the pop-up menu; this will launch the 
Windows Compressed Folders Extraction Wizard (say that ten times fast).

4.  Click “Next.”

5.  Click “Browse” and point the directory at the root level of the Flash Drive (usually marked with an 
“E:/” or an “F:/” designation). Click “OK.”

6.  Click “Next” to start the Extraction. Once that is completed, click “Finish.”

7.  Remove the Flash Drive from your computer and insert it into one of the available USB ports on your 
Digital X Bus.

8.  Select “Install Packages” from the File Menu on the Digital X Bus.

9.  Select the new Digital X Bus build from the list and select “Run Installer.” Select “OK” when asked to 
shut down the Digital X Bus application in order to run the Installer.

10.  Once you are back to the main mixer screen, re-select the “Install Packages” from the File Menu.

11.  If there is a “System Update” fi le in the list and the Status column reads “Needs Update,” then high-
light the “System Update” fi le and select “Install.” But if the Status column reads “Up to Date,” then 
move on to Step #13.

12. Re-boot the console. If it re-boots itself, then move on to Step #13.

13. Select “About” from the Windows menu and verify you are running the same number build you just 
downloaded.

CD ROM Method
***Requires a CD burner attached to your PC as well as a USB CD ROM drive attached to the Digital X Bus***

1. Make sure you have a CD Burner and the appropriate software loaded on your computer.

2. Download the Software update from www.mackie.com to your local hard drive.

3. Right-click on the downloaded fi le and select “Extract All” from the pop-up menu. This will launch the 
Windows Compressed Folders Extraction Wizard.

4.  Click “Next.”

5.  Click “Browse” and click on “Desktop” in the folder list. Then click “Make New Folder.”

6.  Type in a name for this new folder, such as “Digital X Bus Update” or something obvious.

7.  Click on the newly created folder, and then Click “OK.”

8. Click “Next” to start the Extraction. Once that is completed, click “Finish.”
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9. Insert a blank CD ROM into your computer’s CD drive or other attached CD Burner.

10. Open whatever CD burning software you use to create CDs from your PC, and burn all the contents of 
the “Digital X Bus Update” folder (or whatever you named it) directly to the CD. Make sure you fi nalize 
the CD so it can be read by other computers.

11. Remove the CD from your computer or attached CD drive and insert it into the USB CD ROM drive at-
tached to your Digital X Bus.

12. Select “Install Packages” from the File Menu on the Digital X Bus.

13. Select the new build to be installed from the list and select “Run Installer.” Select “OK” when asked to 
shut down the Digital X Bus application in order to run the Installer.

14. Once you are back to the main mixer screen, re-select the “Install Packages” from the File Menu.

15. If there is a “System Update” fi le in the list and the Status column reads “Needs Update,” then high-
light the “System Update” fi le and select “Install.” But if the Status column reads “Up to Date,” then 
move on to Step #17.

16. Re-boot the console. If it re-boots itself, then move on to Step #17.

17. Once you are back to the main mixer screen, select “About” from the Windows menu and verify you are 
running the same number build you just downloaded.

Windows 2000/ME/98SE Users

The procedure for Windows 2000/ME/98SE is identical to the procedure for Windows XP, with the only 
exception being the need to have the WinZip Utility Program installed. WinZip can be downloaded either as 
a demo version (free) or a commercial version (charge) from www.winzip.com and installed on your PC.

USB Flash/Pen Drive Method (recommended)
***Requires a USB Flash/Pen drive with the appropriate drivers for Windows 2000/ME/98SE***

1. Download the Digital X Bus software update from www.mackie.com to your local hard drive.

2. Insert a USB Flash Drive into your computer. You may have to install special drivers to interface your 
PC with your USB Flash drive…see the USB Flash Drive product documentation for more information.

3. Double-click on the fi le you just downloaded, which should open the WinZip Utility.

4. Highlight all fi les displayed in the WinZip window, and select “Extract.”

5. Browse to the base level, “root” directory of the USB Flash Drive and select “OK.”

 Note: Make sure the WinZip utility does not create a master folder on your Flash Drive…if it does, 
then cut the fi les from that master folder and paste them all to the root directory.

6. Remove the Flash Drive from your computer and insert it into one of the available USB ports on your 
Digital X Bus.

7. Select “Install Packages” from the File Menu on the Digital X Bus.

8. Select the new build to be installed from the list and select “Run Installer.” Select “OK” when asked to 
shut down the Digital X Bus application in order to run the Installer.

9. Once you are back to the main mixer screen, re-select the “Install Packages” from the File Menu.

10. If there is a “System Update” fi le in the list and the Status column reads “Needs Update,” then high-
light the “System Update” fi le and select “Install.”  But if the Status column reads “Up to Date,” then 
move on to Step #12.

11. Re-boot the console. If it re-boots itself, then move on to Step #12.

12. Once you are back to the main mixer screen, select “About” from the Windows menu and verify you are 
running the same number build you just downloaded.
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***Requires a CD burner attached to your PC as well as a USB CD ROM drive attached to the Digital X Bus***

1. Make sure you have a CD Burner and the appropriate software loaded on your computer.

2. Download the Software update from www.mackie.com to your local hard drive.

3. Create a new folder on your desktop and label it “Digital X Bus Update.”

4. Double-click on the fi le you just downloaded, which should launch the WinZip Utility.

5. Highlight all fi les displayed in the WinZip window, and select “Extract.”

6. Point the WinZip Extractor to the new “Digital X Bus Update” folder on your desktop and Click “OK.”

7. Once the Extraction is completed, close the WinZip utility.

8. Insert a blank CD ROM into your computer’s CD drive or other attached CD Burner.

9. Open whatever CD burning software you use to create CDs from your PC, and burn all the contents of 
the “Digital X Bus Update” folder (or whatever you named it) directly to the CD. Make sure you fi nalize 
the CD so it can be read by other computers.

10. Remove the CD from your computer or attached CD drive and insert it into the USB CD ROM drive at-
tached to your Digital X Bus.

11. Select “Install Packages” from the File Menu on the Digital X Bus.

12. Select the new build to be installed from the list and select “Run Installer.”  Select “OK” when asked to 
shut down the Digital X Bus application in order to run the Installer.

13. Once you are back to the main mixer screen, re-select the “Install Packages” from the File Menu.

14. If there is a “System Update” fi le in the list and the Status column reads “Needs Update,” then high-
light the “System Update” fi le and select “Install.”  But if the Status column reads “Up to Date,” then 
move on to Step #16.

15. Re-boot the console. If it re-boots itself, then move on to Step #16.

16. Once you are back to the main mixer screen, select “About” from the Windows menu and verify you are 
running the same number build you just downloaded.

Mac OS X Users

USB Flash/Pen Drive (recommended)
***Requires a USB Flash/Pen drive***

1. Insert a USB Flash Drive into your Mac so you can see the icon of that drive on your desktop.

2. Download the Software update from www.mackie.com to your desktop.

3. Double-click on the .zip fi le to create a folder on your desktop labeled after the build version you just 
downloaded.

4. Open that same folder so you can see all the contents and fi les.

5. Drag all the contents of that same folder onto the icon of your Flash Drive.

6. Remove the Flash Drive from your computer and insert it into one of the available USB ports on your 
Digital X Bus.

5. Select “Install Packages” from the File Menu on the Digital X Bus.

6. Select the new build to be installed from the list and select “Run Installer.” Select “OK” when asked to 
shut down the Digital X Bus application in order to run the Installer.

7. Once you are back to the main mixer screen, re-select the “Install Packages” from the File Menu.
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8. If there is a “System Update” fi le in the list and the Status column reads “Needs Update,” then high-
light the “System Update” fi le and select “Install.” But if the Status column reads “Up to Date,” then 
move on to Step #10.

9.  Re-boot the console. If it re-boots itself, then move on to Step #10.

10. Once you are back to the main mixer screen, select “About” from the Windows menu and verify you are 
running the same number build you just downloaded.

CD ROM Method
***Requires a CD Burner attached to your Mac, as well as a USB CD ROM Drive attached to your Digital X Bus***

1. Download the Software update from www.mackie.com to your desktop.

2. Double-click on the .zip fi le to create a folder on your desktop labeled after the build version you just 
downloaded.

3. Open that same folder so you can see all the contents and fi les.

4. Insert a blank CD into your Mac’s CD Drive and confi rm that an icon of that CD appears on your desk-
top.

5. Drag all the contents of the “Digital X Bus x.x.x” folder on your desktop onto the blank CD icon.

6. CTRL+Click on the icon of the blank CD and select “Burn Disc” from the pop up menu. Or, burn and 
fi nalize the CD from Toast or other CD burning software for the Mac. Make sure you burn your CD so 
that it will be readable by both Mac and PC computers.

6. Once the CD has completed burning, eject the CD from your Mac and insert it into the USB CD ROM 
drive attached to your Digital X Bus.

7. Select “Install Packages” from the File Menu on the Digital X Bus.

8. Select the new build to be installed from the list and select “Run Installer.” Select “OK” when asked to 
shut down the Digital X Bus application in order to run the Installer.

9. Once you are back to the main mixer screen, re-select the “Install Packages” from the File Menu.

10. If there is a “System Update” fi le in the list and the Status column reads “Needs Update,” then high-
light the “System Update” fi le and select “Install.” But if the Status column reads “Up to Date,” then 
move on to Step #12.

11. Re-boot the console. If it re-boots itself, then move on to Step #12.

12. Once you are back to the main mixer screen, select “About” from the Windows menu and verify you are 
running the same number build you just downloaded.

Mac OS 9.x Users

This operation on Mac OS 9.x requires the installation of the “Zip It” utility, which is available from 
www.maczipit.com.

USB Flash/Pen Drive (recommended)
***Requires a USB Flash/Pen drive ***

1. Insert a USB Flash Drive into your Mac so you can see the icon of that drive on your desktop.

2. Download the Digital X Bus Software update from www.mackie.com to your desktop.

3. Double-click on the Digital X Bus Software Update fi le you just downloaded, and point the Open File 
Dialog to the Zip It Utility. This should create a folder on your desktop that has the same name as the 
Digital X Bus Software Update fi le.

4. Open that same folder so you can see all the contents and fi les.

5. Drag all the contents of that same folder onto the icon of your Flash Drive.
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Digital X Bus.

5. Select “Install Packages” from the File Menu on the Digital X Bus.

6. Select the new build to be installed from the list and select “Run Installer.” Select “OK” when asked to 
shut down the Digital X Bus application in order to run the Installer.

7. Once you are back to the main mixer screen, re-select the “Install Packages” from the File Menu.

8. If there is a “System Update” fi le in the list and the Status column reads “Needs Update,” then high-
light the “System Update” fi le and select “Install.”  But if the Status column reads “Up to Date,” then 
move on to Step #10.

9. Re-boot the console. If it re-boots itself, then move on to Step #10.

10. Once you are back to the main mixer screen, select the About Window from the Windows Menu and 
verify you are running the same number build you just downloaded.

CD ROM Method
***Requires a CD Burner and any relevant software installed to your Mac, as well as a USB CD ROM Drive 
attached to your Digital X Bus***

1. Download the Software update from www.mackie.com to your desktop.

2. Double-click on the Digital X Bus Software Update fi le you just downloaded, and point the Open File 
Dialog to the Zip It Utility. This should create a folder on your desktop that has the same name as the 
Digital X Bus Software Update fi le.

3. Open that same folder so you can see all the contents and fi les.

4. Insert a blank CD into your Mac’s CD Drive and confi rm that an icon of that CD appears on your desk-
top.

5. Using whatever CD creation/burning software you have installed in your Mac, proceed to burn all the 
fi les in the “Digital X Bus x.x.xxx” folder directly to the root directory of the CD.

 Note: Do not create any additional folders or sub-directories. Make sure you burn your CD so it will be 
readable by various types of computers.

6. Once the CD has completed burning, eject the CD from your Mac and insert it into the USB CD ROM 
drive attached to your Digital X Bus.

7. Select “Install Packages” from the File Menu on the Digital X Bus.

8. Select the new build to be installed from the list and select “Run Installer.” Select “OK” when asked to 
shut down the Digital X Bus application in order to run the Installer.

9. Once you are back to the main mixer screen, re-select the “Install Packages” from the File Menu.

10. If there is a “System Update” fi le in the list and the Status column reads “Needs Update,” then high-
light the “System Update” fi le and select “Install.” But if the Status column reads “Up to Date,” then 
move on to Step #12.

11. Re-boot the console. If it re-boots itself, then move on to Step #12.

12. Once you are back to the main mixer screen, select “About” from the Windows menu and verify you are 
running the same number build you just downloaded.
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A. LOUD Technologies Inc. warrants all materials, workmanship 
and proper operation of this product for a period of ONE year 
from the original date of purchase. If any defects are found 
in the materials or workmanship or if the product fails to 
function properly during the applicable warranty period, LOUD 
Technologies, at its option, will repair or replace the product. 
This warranty applies only to equipment sold and delivered 
within the U.S. by LOUD Technologies Inc. or its authorized 
dealers.
B. Failure to register online or return the product registration 
card will not void the one-year warranty.

C. Service and repairs of Mackie products are to be performed 
only at a factory-authorized facility (see D below). Unauthorized 
service, repairs, or modifi cation will void this warranty. To obtain 
repairs under warranty, you must have a copy of your sales 
receipt from the authorized Mackie dealer where you purchased 
the product. It is necessary to establish the purchase date and 
determine whether your Mackie product is within the warranty 
period. 

D. To obtain factory-authorized service:

1. Call Mackie Technical Support at 800/898-3211, 7 AM 
to 5 PM Monday through Friday (Pacifi c Time) to get a 
Service Request Number. Products returned without a Service 
Request Number will be refused. 

2. Pack the product in its original shipping carton. Also 
include a note explaining exactly how to duplicate the 
problem, a copy of the sales receipt with price and date 
showing, and your return street address (no P.O. boxes or 
route numbers, please!). If we cannot duplicate the problem 
or establish the starting date of your Limited Warranty, we 
may, at our option, charge for service time.

3. Ship the product in its original shipping carton, freight 
prepaid to the authorized service center. The address of 
your closest authorized service center will be given to you by 
Technical Support.

IMPORTANT:  Make sure that the Service Request Number 
is plainly written on the shipping carton.

E. LOUD Technologies reserves the right to inspect any products 
that may be the subject of any warranty claims before repair 
or replacement is carried out. LOUD Technologies may, at our 
option, require proof of the original date of purchase in the form 
of a dated copy of the original dealer’s invoice or sales receipt. 
Final determination of warranty coverage lies solely with LOUD 
Technologies. 

F. Any product returned to one of the LOUD Technologies 
factory-authorized service centers and deemed eligible for repair 
or replacement under the terms of this warranty will be repaired 
or replaced within thirty days of receipt. LOUD Technologies 
and its authorized service centers may use refurbished parts 
for repair or replacement of any product. Products returned to 
any authorized service center that do not meet the terms of 
this warranty will not be repaired and returned unless payment 
is received for labor, materials, return freight, and insurance. 
Products repaired under warranty will be returned freight 
prepaid by LOUD Technologies to any location within the 
boundaries of the USA.

G. LOUD Technologies warrants all repairs performed for 90 
days or for the remainder of the warranty period. This warranty 
does not extend to damage resulting from improper installation, 
misuse, neglect or abuse, or to exterior appearance. This 
warranty is recognized only if the inspection seals and serial 
number on the unit have not been defaced or removed.

H. LOUD Technologies assumes no responsibility for the quality or 
timeliness of repairs performed by an authorized service center.

I. This warranty is extended to the original purchaser and to 
anyone who may subsequently purchase this product within the 
applicable warranty period. A copy of the original sales receipt is 
required to obtain warranty repairs.

J. This is your sole warranty. LOUD Technologies does not 
authorize any third party, including any dealer or sales 
representative, to assume any liability on behalf of LOUD 
Technologies or to make any warranty for LOUD Technologies Inc.

K. THE WARRANTY GIVEN ON THIS PAGE IS THE SOLE 
WARRANTY GIVEN BY LOUD TECHNOLOGIES INC. AND IS IN 
LIEU OF ALL OTHER WARRANTIES, EXPRESS AND IMPLIED, 
INCLUDING THE WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. THE WARRANTY 
GIVEN ON THIS PAGE SHALL BE STRICTLY LIMITED IN 
DURATION TO ONE YEAR FROM THE DATE OF ORIGINAL 
PURCHASE FROM AN AUTHORIZED MACKIE DEALER. UPON 
EXPIRATION OF THE APPLICABLE WARRANTY PERIOD, LOUD 
TECHNOLOGIES INC. SHALL HAVE NO FURTHER WARRANTY 
OBLIGATION OF ANY KIND. LOUD TECHNOLOGIES INC. 
SHALL NOT BE LIABLE FOR ANY INCIDENTAL, SPECIAL, OR 
CONSEQUENTIAL DAMAGES THAT MAY RESULT FROM ANY 
DEFECT IN THE MACKIE PRODUCT OR ANY WARRANTY 
CLAIM. Some states do not allow exclusion or limitation of 
incidental, special, or consequential damages or a limitation on 
how long warranties last, so some of the above limitations and 
exclusions may not apply to you. This warranty provides specifi c 
legal rights and you may have other rights which vary from state 
to state.

Please keep your sales receipt in a safe place.

Digital X Bus Limited Warranty
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